
    
User Manual

BBEdit Lite 6.1
Free Text Editor for the Macintosh

Bare Bones Software, Inc.



                  
BBEdit Lite 6.1.1

Design and Implementation Rich Siegel, Patrick Woolsey, Jim Correia

Product Engineering Jim Correia, Jon Hueras, Steve Kalkwarf, 
Rich Siegel

Engineers Emeritus Chris Borton, Tom Emerson, 
Pete Gontier, Scott Marcy, 
Jamie McCarthy, John Norstad, 
Jon Pugh, Mark Romano,
Leonard Rosenthol, Rob Vaterlaus

Quality Assurance David Russell, Christian Smith, 
Patrick Woolsey

Documentation John Gruber, Jerry Kindall,
Philip Borenstein, Simon Jester,
Rich Siegel, Patrick Woolsey

Infinity Windoid by Troy Gaul, © 1991-1995
Infinity Systems

Mercutio MDEF written by and copyright © 1993-2000
Ramon Felciano

Installer VISE™ courtesy of MindVision Software
<http://www.mindvision.com/>

BBEdit Lite and the BBEdit Lite User Manual are copyright ©1992-
2001 Bare Bones Software, Inc. All rights reserved. Prepared/printed 
in USA.



        
Bare Bones Software, Inc.
P. O. Box 1048
Bedford, MA 01730–01048

(781) 687-0700
(781) 687-0711 fax

(Please note that technical support for BBEdit Lite is not available via 
phone or fax, only via email or our web site.)

http://www.barebones.com

Sales information: sales@barebones.com
Tech Support: support@barebones.com

“BBEdit” and “BBEdit Lite” are trademarks, and “It Doesn’t Suck” is a 
registered trademark of Bare Bones Software, Inc.

Information in this document is subject to change without notice and 
does not represent a commitment on the part of the copyright holder. 
The software described in this document is furnished under a license 
agreement. This document may not, in whole or in part, be copied, 
photocopied, reproduced, translated, or reduced to any electronic 
medium or machine-readable form without prior consent, in writing, 
from the copyright holder.

Warranty and license information is contained in Chapter 1 and 
included in text document form in the application folder.

Frontier is a trademark of UserLand Software. CodeWarrior is a 
trademark of Metrowerks, Inc. Macintosh, Mac OS, Mac OS X, Power 
Macintosh, AppleScript, MPW and ToolServer are trademarks of 
Apple Computer, Inc. PowerPC is a trademark of International 
Business Machines Corp. All other trademarks are the property of 
their respective owners.

http://www.barebones.com


 

 



                                                 
Table of Contents

Chapter 1 Welcome to BBEdit Lite 1
What is BBEdit Lite?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
How Can I Use BBEdit Lite? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1
BBEdit Lite is Freeware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
License Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
What’s New in BBEdit Lite 6.1? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
What’s Different from the Commercial Version of BBEdit? . . . . . . . .  4

HTML Editing – 5
Advanced Text Editing – 5
Scripting – 5
Programming – 6
Even More – 6

Human Interface Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Dynamic Menus – 7
Bypassing Options Dialogs – 7
Menu Command Keys – 7
Contextual Menus – 8
Dialog Box Command Keys – 8

Getting Started  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Changes from Previous Versions . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10

Chapter 2 Installing BBEdit Lite 11
Basic Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Internet Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
BBEdit Lite Support Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Plug-ins – 12
Shutdown Items – 13
Startup Items – 13

Other BBEdit Lite Files and Folders  . . . . . . . . . . . . . . . . . . . . . . . . . .  14
BBEdit Lite Preferences Folder – 14
BBEdit Lite Prefs Data – 14
Clipboards – 14
Grep Patterns – 14
Recent Files & Favorites – 15
Recent Folders & Favorites – 15
v



                                                                  
Chapter 3 Working with Files 17
Launching BBEdit Lite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Startup Items – 17
Memory Considerations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18
Creating and Saving New Documents  . . . . . . . . . . . . . . . . . . . . . . . .  18

Save As Options – 19
File Saving Options – 20

Opening Existing Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  23
Using the Open Command – 24
Using the Open Hidden Command – 25
Using the Open Recent Command – 25
Using the Open Several Command – 26
Using the Open Selection Command – 27

Using Stationery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
Making Backups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28

Automatic Backups – 29
Manual Backups – 29

Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Options Available from Print Dialog – 31
The Printing Options Command – 31

Chapter 4 Editing Text with BBEdit Lite 35
Basic Editing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

Moving text – 37
Multiple Clipboards – 37
Drag and Drop – 39

Multiple Undo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39
Window Anatomy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40

The Status Bar – 40
The Split Bar – 42

Cursor Movement and Text Selection  . . . . . . . . . . . . . . . . . . . . . . . . .  42
Clicking – 43
Arrow Keys – 43
The Delete Key – 45
The Numeric Keypad – 46
Go To Line Command – 46
Function Keys – 47

Text Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
Editing Options – 48
Display Options – 49

Font & Tabs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
vi Table of Contents



                                                                   
Text Transformation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Balance – 51
Exchange Characters – 52
Change Case – 52
Shift Left and Shift Right – 53
Add Line Breaks – 53
Remove Line Breaks – 53
Rewrap Quoted Text – 54
Increase and Decrease Quote Level – 54
Strip Quotes – 54
Hard Wrap – 54
Zap Gremlins – 55
Entab – 56
Detab – 56
Resolve URL – 57

How BBEdit Lite Wraps Text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  57
Soft Wrapping – 58
Hard Wrapping – 59

The Insert Submenu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  62
Inserting Files – 62
Inserting a Folder Listing – 62
Inserting Paths – 63
Inserting a Page Break – 63

Chapter 5 Working with Windows 65
Window Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
Minimize Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
Bring All to Front. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  65
Window List. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66
Arrange . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  66
Get Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68
Reveal in Finder. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  68
Send To Back  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Exchange With Next . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Synchro Scrolling. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69
Window Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  69

Chapter 6 Searching 71
Basic Searching and Replacing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  72

Search Settings – 74
Special Characters – 75

Multi-File Searching . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  76
Multi-File Search Results: Batch Find – 78
Multi-File Search Results: File by File – 79
Specifying the Search Set – 79
Multi-File Search Options – 81

Multi-File Replacing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  81
Replacing in Files with Projector CKIDs – 83
Table of Contents vii



                       
Search Menu Reference  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  84
Find – 84
Find Again – 84
Find Selection – 84
Enter Search String – 84
Replace – 84
Replace All – 84
Replace & Find Again – 85
Find in Next File – 85
Open All Matches – 85
Find & Replace All Matches – 85
Go to Line – 85
Go to Center Line – 85

Chapter 7 Searching with Grep 87
What is Grep or Pattern Searching? . . . . . . . . . . . . . . . . . . . . . . . . . . .  88
Recommended Books and Resources  . . . . . . . . . . . . . . . . . . . . . . . . .  88
Writing Search Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  89

Most Characters Match Themselves – 89
Escaping Special Characters – 89
Wildcards Match Types of Characters – 90
Character Classes Match Sets
or Ranges of Characters – 90
Matching Non-Printing Characters – 92
Other Special Characters – 92
Repetition Metacharacters Repeat Other Patterns – 93
Combining patterns to make complex patterns – 94
Creating Subpatterns – 94
Using Alternation – 96
The ‘Longest Match’ Issue – 96

Writing Replace Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  98
Subpatterns Make Replacement Powerful – 98
Using the Entire Matched Pattern – 98
Using Parts of the Matched Pattern – 99
Case Transformations – 100

Examples  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  101
Matching Identifiers – 101
Matching White Space – 101
Matching Delimited Strings – 102
Marking Structured Text – 103
Marking a Mail Digest – 103
Rearranging Name Lists – 104
Modifying HTML tags – 104
viii Table of Contents



Chapter 8 Preferences 107
The Preferences Command . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  108
Application Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  109

Optional Application Services – 109
Optional Mac OS Services – 109
Show Full Paths in “Open Recent” Menu – 110
Window menu – 110
Remember Dialog Box Placement – 111

Browser Display Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  111
Results Lists – 111

Editor Defaults Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  112
Auto-Indent – 112
Balance while Typing – 112
Smart Quotes – 112
Smart Editing – 113
Auto-Expand Tabs – 113
Show Invisibles – 113
Show Spaces – 113
Soft Wrap Text – 114
Default Font – 114

File Search Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  115
Find All Matches – 115
Skip (…) Folders – 115
Follow Folder Aliases – 115
Default <…> Directory – 116
Unix Search Paths – 116

File Types Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117
To set the default creator signature – 117
To add a new application to the list – 117
To delete an item from the list – 117

Startup Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  118
Do Nothing – 118
New Text Document – 118
Open – 118
Open Several – 118

State Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  119
Honor Saved State – 119
Default Saved State – 120
Always Add State – 120

Status Bar Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
Show Status Bar – 120
Show Philip Bar – 121
Show Tab Stops – 121
Show Line Numbers – 121
Show Cursor Position – 121
Window Options – 121
File Options – 121
Insert Menu – 121
File Path – 121
Get Info Icon – 121
Document Icon – 122
Show All/Hide All – 122
Button Puffiness – 122
Table of Contents ix



Text Editing Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Enable Shift-Delete for Forward Delete – 122
Drag & Drop Editing – 123
Use Numeric Keypad for Cursor Movement – 123
Allow Single-Click Line Selection – 123
Confirm Non-Undoable Editing Actions – 124
Use ‘Hard’ Line Numbering… – 124
Exchange Command and Option Key Behavior – 124
Allow Text Smoothing – 124
Extra Space in Text Views – 124

Text Files: Opening Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  125
Translate Line Breaks – 125
If a File’s Type is Unknown – 125

Text Files: Saving Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  126
Force New Line at End – 126
Default Line Breaks – 126
Make Backups Before Saving – 127

Text Printing Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127
Default for Page Setup – 127
Defaults for Printing – 127
Default Font – 128
Use Document’s Font – 128
Fractional Widths – 128
Print Backwards – 128
Frame Printing Area – 128
Print Page Headers – 128
Print Full Pathname – 128
Print Line Numbers – 128
Print Two-Up – 128
1-Inch Gutter – 129
Time Stamp – 129

Text Search Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  129
Report Single-File “Replace All” Results – 129
Remember Start At Top Setting – 129
Grep Patterns – 129

Windows Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  130
Window Zooming – 130
Always Zoom Windows – 130
Move As Little As Possible – 130
Window Stacking – 131
Leave Room for Finder – 131
x Table of Contents



Chapter 9 BBEdit Lite Plug-Ins 133
Using BBEdit Lite Plug-Ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  133

The Tools Menu and Floating Window – 134
The Set Key Button – 134

Supplied Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  135
Add/Remove Line Numbers – 135
Clear Lines Containing – 135
Columnize – 135
Concatenate – 135
Convert to ASCII – 135
Copy Lines Containing – 136
Cut Lines Containing – 136
Educate Quotes – 136
Hex Dump – 136
Make Prototypes – 136
Prefix/Suffix Lines – 136
Reverse – 136
Salary Adjust – 136
Send PostScript™ – 137
Sort – 137

Third-Party Plug-ins  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  138
Finding more plug-ins – 138
Mac OS X Plug-ins – 138

Appendix A Command Reference 139
Assigning Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  139
Listing by Menu and Command Name  . . . . . . . . . . . . . . . . . . . . . .  140
Listing by Default Key Equivalents . . . . . . . . . . . . . . . . . . . . . . . . . .  142

Appendix B Editing Shortcuts 145
Mouse Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  145
Arrow and Delete Keys . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  146
Table of Contents xi



xii Table of Contents



C H A P T E R

1
Welcome to BBEdit Lite

This chapter introduces you to BBEdit Lite, a high-performance 
HTML and text editor for the Macintosh. 
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What is BBEdit Lite?
BBEdit Lite is a free text editor for the Macintosh based on the award-
winning BBEdit. Unlike a word processor, which is designed for 
preparing printed pages, a text editor focuses on providing means of 
producing and changing content. Thus, BBEdit Lite doesn’t offer fancy 
formatting capabilities, headers and footers, graphics tools, a 
thesaurus, and other staples of modern feature-laden “office” 
software. Instead, it focuses on helping you manipulate text in ways 
that word processors generally can’t.

In service of this goal, BBEdit Lite offers regular expression-based 
(“grep”) search and replace, multi-file search, sophisticated text 
transformations, and other features not usually found (or missed) in 
word processors.

How Can I Use BBEdit Lite?
Use BBEdit Lite any time you need to create or edit text documents of 
any kind. Whether you need to find (or change!) all the occurrences of 
some text in a set of files, or modify or reformat large text files, or 
quickly tweak a Web page, BBEdit Lite is a great tool for the job.
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BBEdit Lite is Freeware
BBEdit Lite is a freely distributable, copyrighted program, otherwise 
known as “freeware”. There is no registration process, no fee 
requested or required, no obligation on your part, and no guilt.

We at Bare Bones Software do not produce or develop “shareware”; it 
has been our direct experience that many people simply ignore 
shareware notices. The costs related to distributing BBEdit Lite are 
low, and can be recouped by means other than (unsuccessfully) trying 
to shame users into paying some small amount of money for a 
program.

We believe that when users of a program make the financial sacrifice 
to obtain a piece of software, they should expect, and receive, 
significant value added. This is why a commercial distribution of 
BBEdit exists.

If you feel compelled to pay us for BBEdit Lite, don't. If you need the 
capabilities that the commercial version of BBEdit has to offer, we 
encourage you to order your own copy of BBEdit. See the information 
in the folder “Upgrading to BBEdit 6.1" for more details.

License Requirements
Although BBEdit Lite is free, it is not “public domain”. It is a 
copyrighted software program, and Bare Bones Software, Inc. reserves 
all rights; therefore:

• BBEdit Lite cannot be sold, either by itself or in combination 
with any other product, without the express written 
permission of Bare Bones Software, Inc.

• If you are a user group which is publishing a CD-ROM or 
floppy collection, you may include BBEdit Lite and all of its 
related files without restriction, save that the entire original 
package is included. Contact Bare Bones Software for up-to-
date versions and information.

• If you are a hard disk vendor which distributes PD, shareware, 
and freeware on your disk drives, you are welcome to 
distribute BBEditLite. Contact Bare Bones Software for up-to-
date versions and information.

• Commercial publishers and distributors of CD-ROM software 
collections, to include any and all software compilations 
provided as an adjunct to printed or online publications, may 
not distribute BBEdit Lite on CD-ROM without the express 
written permission of Bare Bones Software, Inc.
2 Chapter 1: Welcome to BBEdit Lite



• BBEdit Lite may be posted on an information service which 
charges its users for general connection time and 
downloading, but it may NOT be posted to an information 
service which will charge for the specific right to download 
BBEdit Lite, without the express written permission of Bare 
Bones Software, Inc.

• BBEdit Lite may be given away as a support utility for a 
package which is itself to be given away. People who need to 
distribute BBEdit Lite as a support utility should contact Bare 
Bones Software for up-to-date versions and information.

Please address all correspondence to:

Bare Bones Software, Inc.
P.O. Box 1048
Bedford, MA 01730

<http://www.barebones.com/>

or email: 

<sales@barebones.com>   — licensing inquiries only
<support@barebones.com> — all technical questions

Please note that we cannot provide technical support for BBEdit Lite 
(or any of our other freeware products) via phone or fax.

What’s New in BBEdit Lite 6.1?
The following features highlight the significant improvements in 
BBEdit Lite 6.1 from the previous version, BBEdit Lite 4.6.

• Runs natively on Mac OS X
• Quoted text rewrapper 
• Support for BBEdit floating palette plug-ins
• Improved grep syntax
• Multiple Undo 
• Multiple Clipboards 
• Extensively configurable key equivalents 
• Navigation Services and Appearance Manager support 
• Floating window list 
• Splittable editing windows 
• Automatic backup of files when saving (optional) 
What’s New in BBEdit Lite 6.1? 3



What’s Different from the Commercial 
Version of BBEdit?
BBEdit Lite offers only a subset of the features available in the 
commercial version of BBEdit. The features offered in BBEdit Lite are 
the core functions of a general text editor—editing, searching, 
replacing, etc. The commercial version of BBEdit offers numerous 
advanced features which are targeted at specific applications:

• Support for multi-byte text and Unicode files 
• Full OSA scripting support—extensively scriptable, 

recordable, and attachable
• OSA Scripts palette 
• Perl integration—apply text filters or develop scripts with 

MacPerl on Mac OS 9 and earlier, and with the native Unix Perl 
tools on Mac OS X 

• Compare and find differences between individual files or the 
contents of folders 

• Built-in FTP tool with Keychain support 
• Disk browsers 
• Quick Search window 
• Advanced file filtering for multi-file search and replace 
• Powerful Glossary with language-sensitive sets 
• Complete set of HTML Tools—for fast, easy, and correct 

markup 
• Floating HTML Tools palette 
• Keyboard-driven tag editing tools 
• HTML markup from contextual menus 
• Preview in any Mac browser 
• GoLive and PageMill cleaner tools 
• Standards-based Syntax Checker—check single pages or entire 

sites for compliance with all current HTML standards as well 
as XHTML 1.0 and WML 1.1

• Web-safe Colors palette
• Comprehensive HTML Entities palette 
• Integration with Macromedia 
• Integrated HTML-aware spelling checker 
• Developer-extensible syntax coloring 
• Built-in function scanner with support for 15 languages 
• Seamless integration with Metrowerks CodeWarrior IDE 
• Integration with THINK Toolbox Assistant and MPW 411 

reference 
• Support for MPW ToolServer 
• Comprehensive printed manual plus online HTML Help
4 Chapter 1: Welcome to BBEdit Lite



HTML Editing
BBEdit’s complete set of HTML authoring tools enable fast, easy, and 
correct markup, and are especially suited for web developers who care 
about the quality of their HTML code. These HTML tools are 
accessible several ways—a floating HTML Tools palette, a Markup 
menu (with user-configurable keyboard shortcuts), and a contextual 
menu within document windows. BBEdit offers robust integration 
with all Mac web browsers, allowing you to preview your web pages 
in multiple browsers with a single click or keystroke.

The standards-based Syntax Checker checks single pages or entire 
sites for compliance with all current HTML standards, as well as 
XHTML, CHTML, and WML. 

BBEdit offers special floating palettes for HTML Entities and Web-Safe 
colors. GoLive and PageMill cleaner tools clean-up the code generated 
by other HTML editors.

Advanced Text Editing
BBEdit allows you to edit multi-byte text and Unicode files in any left-
to-right language supported by the Mac OS. These features are 
essential for working with text written in languages with non-Roman 
alphabets.

BBEdit offers powerful tools for comparing and finding differences 
between files and folders. The built-in FTP tool allows you to edit and 
save files on remote FTP servers, and supports the Mac OS Keychain 
for storing passwords securely.

File Filters provide a powerful method for searching only in specific 
files, for example, allowing you to search for text in files whose names 
end with “.html” and were created after a certain date.

The Glossary palette offers quick access to frequently used snippets of 
text. BBEdit’s Glossary is language-sensitive, so you can specify 
different Glossary sets for languages like HTML, Perl, and C. Glossary 
items can include special placeholders to generate text dynamically 
(for example, you can make a Glossary entry that includes the current 
date).

The built-in spelling checker is HTML-aware, and ships with 
dictionaries for American, British, Spanish, French, Dutch, and more. 
BBEdit also works with third-party Word Services spelling checkers 
like Excalibur and Spell Catcher.

Scripting
BBEdit offers full OSA scripting support—it is extensively scriptable, 
recordable, and attachable. The script menu and floating script palette 
let you easily launch your scripts or assign keyboard shortcuts to 
them.
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Scriptability allows you to automate repetitive actions, saving you 
enormous amounts of time. Recordability means you can record your 
actions and generate working AppleScripts without writing a line of 
code. Attachability means you can “attach” a script of your choosing 
to any menu command in BBEdit, either working in addition to the 
built-in command, or replacing it entirely. AppleScript is an essential 
and unique Mac OS technology, and BBEdit is the best scriptable text 
editor available.

Programming
BBEdit offers syntax coloring and function scanning for many 
languages, including HTML, Perl, C/C++, Java, JavaScript, PHP, and 
more. Plus, the language module plug-in architecture allows third-
party developers to add support for new languages.

BBEdit is the premier Mac OS source code editor for Perl, integrating 
with MacPerl on Mac OS 9 and earlier, and the native Unix Perl tools 
on Mac OS X. BBEdit allows you to check syntax, run, and debug your 
Perl scripts. BBEdit’s Perl Filters palette is a floating list of Perl scripts 
that can manipulate the current document selection—effectively 
allowing you to write text-munging plug-ins in Perl.

For application developers, BBEdit offers seamless integration with 
the Metrowerks CodeWarrior IDE and MPW ToolServer. (BBEdit is 
written using BBEdit.) Plus, BBEdit works with external API 
references like THINK Toolbox Assistant, MPW 411, Obi Wan, and the 
Mac OS X Developer Help.

Even More
BBEdit ships with a comprehensive printed user manual and online 
HTML Help. Users of BBEdit Lite are eligible to upgrade to the 
commercial version of BBEdit at a substantial discount. Visit our web 
site or call our sales department to find out more.
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Human Interface Notes
BBEdit Lite enhances menus and dialogs as follows.

Dynamic Menus
Many of BBEdit Lite’s pull-down menus are dynamic. If you hold 
down the Shift or Option keys while a menu is open, you can see some 
of the items change. The illustration below shows what the File menu 
looks like normally (left) and when you hold down the Option key 
(right).

You can use the Shift and Option keys when you choose an item from 
a menu or when you use the Command key equivalents.

Bypassing Options Dialogs
You may have noticed that commands which require additional 
settings to be made before they are performed appear on the menu 
with ellipses after their names. To bypass this step and use the 
command with its most recent settings, hold down the Option key 
while selecting the menu item. For example, Zap Gremlins… from the 
Text menu becomes Zap Gremlins when the Option key is pressed, 
and when selected, will zap gremlins in the frontmost text document 
using the current settings.

Menu Command Keys
Many of BBEdit Lite’s commands have keyboard shortcuts. BBEdit 
Lite 6.1 lets you re-assign the shortcuts for any menu item or plug-in 
to suit your own way of working. Choose Set Menu Keys from the 
Edit menu to set the keys for menu items.
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Many other BBEdit Lite features can have keyboard shortcuts 
assigned as well. Here’s how to set them:

Contextual Menus
When you control-click on selected text or at the insertion point in a 
text window, BBEdit Lite’s contextual menu provides quick access to a 
few of the most frequently-needed functions, so you don’t have to 
hunt around in the menu bar for them.

Dialog Box Command Keys
You can use command keys to click buttons or select options in most 
of BBEdit Lite’s dialogs. Certain keys have the same meaning in all 
dialog boxes:

• Pressing the Return or Enter key is the same as clicking the 
default button.

• Typing Command-Period or pressing the Escape key is the 
same as clicking the Cancel button.

• You can use the Cut, Copy, Paste, Clear, and Select All 
commands in any dialog box that has a text field (either from 
the Edit menu or with their key equivalents).

To see the other key equivalents for a dialog box, hold down the 
Command key. After a brief delay, the key equivalents appear next to 
the buttons in the dialog.

Feature Set keys in…

Menu Commands Set Menu Keys… (Edit menu)

Plug-ins Tools List (Tools menu)
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For example, this is the Find & Replace dialog without the Command 
key equivalents showing:

This is the Find & Replace dialog box with the Command key 
equivalents visible.

BBEdit Lite waits briefly before displaying the Command key 
equivalents so that you can type a sequence quickly without making 
the dialog box flicker.
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Getting Started
The next chapter tells you how to install BBEdit Lite on your 
Macintosh. If you are already familiar with previous versions of 
BBEdit Lite, you can start using the application right away. If you have 
never used BBEdit Lite before, we recommend that you read at least 
Chapters 2 through 6 to learn more about the application.

Changes from Previous Versions
BBEdit Lite 6.1 represents a major under-the-hood reworking of the 
software which has allowed us to add many important new 
capabilities, and to prepare for the future. Here’s a quick overview.

• BBEdit Lite 6.1 now runs natively on Mac OS X. The BBEdit 
Lite application is supplied in two forms: a “Classic” version, 
for machines running Mac OS 7.5.5 through 9.1, and a 
“Carbon” version, for machines running Mac OS X. (Please 
note that you cannot run the Classic version of BBEdit Lite in 
the Classic environment on Mac OS X, and you cannot run the 
Carbon version on Mac OS 9 or earlier.)

• Contextual menu support.

• Multiple clipboards, to ease copying and moving multiple bits 
of text.

• Appearance Manager and Navigation Services support.

New in 6 BBEdit Lite 6.1 also contains a bevy of additional improvements, 
tweaks, and bug fixes throughout the program. Look for the “New in 
6” marker in the margin throughout this manual to find things that 
have changed significantly or been added since the last major version, 
BBEdit Lite 4.6.

Mac OS X To indicate changes in the functionality or behavior of BBEdit Lite 6.1 
under Mac OS X, look for the “Mac OS X” marker in the margin. (As 
above, you may also search for this marker in the PDF version of the 
manual.)

For a detailed summary of all recent changes, see BBEdit Lite’s online 
help (available from the Help menu) or visit the BBEdit Lite support 
section of our Web site.
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C H A P T E R

2
Installing BBEdit Lite

This chapter tells you how to install BBEdit Lite on your Macintosh. It 
also describes the files the BBEdit Lite installer creates, where it puts 
them, and how to install or remove optional components of BBEdit 
Lite.

In this chapter
Basic Installation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
Internet Control Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .11
BBEdit Lite Support Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .12
Other BBEdit Lite Files and Folders  . . . . . . . . . . . . . . . . . . . . . . . . . .14

Basic Installation
The BBEdit Lite application is now supplied in two form: a “Classic” 
version, for machines running Mac OS 7.5.5 through 9.1, and a 
“Carbon” version, for machines running Mac OS X. 

In order to install BBEdit Lite, you should drag the folder containing 
the BBEdit Lite application(s) from the self-mounting disk image to 
the Applications folder (or other desired folder) on your hard drive.

Mac OS X You cannot run the Classic version of BBEdit Lite in the Classic environment on 
Mac OS X, and you cannot run the Carbon version on Mac OS 9 or earlier. We 
recommend that you install only the version necessary for your operating 
environment. 

New in 6 If you are upgrading from a previous version of BBEdit Lite, please 
read the section “BBEdit Lite Support Folders” carefully, since the 
organization of supporting files has changed in BBEdit Lite 6.1. We 
have provided specific suggestions and tips for transferring your 
custom support files with each category.

The following sections describe some of the BBEdit Lite files and 
additional software that you may wish to use.

Internet Control Panel
On Mac OS 9 and earlier, the Internet control panel (located in the 
Control Panels folder on your startup disk) is a software module that 
keeps track of which Internet client applications you use (Web 
browser, FTP program, etc.), what your email address is, which news 
server you use, which mail server holds your mail, and many other 
Internet-related settings. This control panel has been included as part 
of the system software since Mac OS 8.5, and replaces the stand-alone 
Internet Config application.
11



Note If you are running a version of Mac OS prior to 8.5, then you will need to 
install version 2.0 or later of the Internet Config application in order to use the 
Internet Helpers menu.

By default, BBEdit Lite will display the client applications designated 
in the Internet control panel on the Internet Helpers menu (left). You 
can use this menu to launch any displayed client application from 
within BBEdit Lite.

If you wish to suppress this menu, turn off the Internet Helpers Menu 
option in the Application panel of the Preferences. Having the menu 
active is not necessary in order to use the Resolve URL command or its 
Command-click shortcut.

BBEdit Lite Support Folders
This section describes some folders that BBEdit Lite scans when you 
launch it. Although they’re not essential for day-to-day use, they 
provide additional functionality you may want to use. If you’re 
working on a Macintosh with limited disk space or limited memory 
(RAM), and you don’t need the functionality these folders provide, 
you can remove them.

New in 6 All these folders are in a folder called BBEdit Lite Support, which is in 
the same folder as the BBEdit Lite application. (In previous versions of 
BBEdit Lite, all of these folders, some with slightly different names, 
were in the same folder as the BBEdit Lite application.)

Note In order to prevent alias loops, BBEdit Lite will not follow aliases to folders 
which are placed inside any of the folders contained in the BBEdit Lite Support 
folder. We also recommend that you do not try to share plug-ins or tools 
between BBEdit Lite and other applications, and that you not make aliases to 
plug-ins or tools located on remote (server) volumes.

Plug-ins
The Plug-ins folder contains a standard set of code modules that add 
additional features to BBEdit Lite. You can place plug-ins within sub-
folders (one level deep) to organize them. If you’re not planning to use 
any of the included BBEdit Lite plug-ins, you can remove the Plug-ins 
folder from the BBEdit Lite Support folder. (Some of the functions 
discussed in this manual may require one plug-in or another.)

Note BBEdit plug-ins were formerly known as BBEdit extensions. Plug-ins are 
identical to BBEdit extensions; only the name has been changed. Plug-ins are 
also sometimes referred to as tools, since they appear on the Tools menu in 
BBEdit Lite.

If you are interested in writing your own BBEdit Lite plug-ins, visit 
the Support section of our web site and look for the BBEdit Extension 
Developers Kit.
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Upgrading If you have any third-party plug-ins that you wish to use with BBEdit Lite 6.1 
under Mac OS 9 or earlier, you may move or copy them into the Plug-ins 
folder. 

Mac OS X You will not be able to use any third-party plug-ins which have not been 
updated to function under Mac OS X with BBEdit Lite 6.1. Contact the 
developers of your plug-ins or visit the Bare Bones web site for more 
information on the availability of updated plug-ins.

WARNING You should not use any of the factory-supplied plug-ins from previous 
versions of BBEdit Lite with BBEdit Lite 6.1.

Shutdown Items
New in 6 The items in this folder are opened when you quit BBEdit Lite. This 

folder is installed empty by default.

Startup Items
When launched, BBEdit Lite will look for a folder named Startup 
Items in the BBEdit Lite Support folder, which is in the same folder as 
the application. If this folder is found, BBEdit Lite will open any 
documents it finds in that folder. If the file is one BBEdit Lite knows 
how to open (such as a text file), BBEdit Lite will open a document 
window appropriate to the file. This folder is installed empty by 
default.

If you place other types of documents in this folder, BBEdit Lite will 
ask the Finder to open them. If you often edit HTML files, for instance, 
you may want to place an alias to your Web browser (or your visual 
HTML editor) in the BBEdit Lite Startup Items folder so that it will 
start up automatically whenever you run BBEdit Lite.

Upgrading You can copy or move any document or application aliases from the Startup 
Items folder of your previous version of BBEdit Lite.
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Other BBEdit Lite Files and Folders
When you start up BBEdit Lite it may create the following files and 
folders:

BBEdit Lite Preferences Folder
New in 6 BBEdit Lite stores various settings files in a folder named BBEdit Lite 

Preferences, which can be located either in the BBEdit Lite Support 
folder or in the Preferences folder of your System folder. The settings 
in the BBEdit Lite Support folder have precedence, although if neither 
is found, BBEdit Lite will create a set of default preferences in your 
system Preferences folder.

Mac OS X Under Mac OS X, the default location for the BBEdit Lite Preferences folder is 
in the Preferences folder in the Library folder in the current user’s home folder. 
Settings in the BBEdit Lite Support folder have precedence.

BBEdit Lite Prefs Data
Basic BBEdit Lite settings are stored in a file called BBEdit Lite Prefs 
Data in the BBEdit Lite Preferences folder. 

Upgrading BBEdit Lite 6.1 will not import preference settings from any previous version, 
so you will need to reset any preferences for which you do not want to use the 
factory default value.

Clipboards
BBEdit Lite stores the last-used Clipboard contents (for each of its 
multiple clipboards) in this file upon quitting. This file is new to 
BBEdit Lite 6.1.

Note If you lock the Clipboards file, by selecting it in the Finder, doing Get Info, and 
setting the Lock option, BBEdit Lite will not preserve clipboard contents across 
runs.

Grep Patterns
BBEdit Lite stores user-defined search patterns in this file, which is 
found in your active BBEdit Lite Preferences folder. (In some previous 
versions of BBEdit Lite, these patterns were stored in the Prefs file).

Upgrading If you have added any custom grep patterns to a previous version of BBEdit 
Lite, you can replace the default file created by BBEdit Lite with your 
customized version. Also, if you use a substantial number of custom patterns, 
we recommend that you maintain a backup copy of this file.
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Recent Files & Favorites
New in 6 This folder contains up to 12 aliases to the most recent local files that 

you have opened, or FTP clippings for any files opened from FTP 
servers. The items stored in this folder are used to create the Open 
Recent list on BBEdit Lite’s File menu.

Note You may lock any items in this folder to have them persist as Favorites. Locked 
items will be displayed at the bottom of the list below a separator line, and are 
not counted against the 12 item limit.

Recent Folders & Favorites
New in 6 This folder contains up to 12 aliases to folders which have recently 

been searched. The items stored in this folder are used to create the 
folder search popup menu in the Find dialog.

Note You may lock any items in this folder to have them persist as Favorites. Locked 
items will be displayed at the bottom of the list below a separator line, and are 
not counted against the 12 item limit.
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C H A P T E R

3
Working with Files

This chapter discusses how to use BBEdit Lite to manipulate text files.

In this chapter
Launching BBEdit Lite  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17

Startup Items – 17
Memory Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
Creating and Saving New Documents  . . . . . . . . . . . . . . . . . . . . . . . .18

Save As Options – 19
File Saving Options – 20

Opening Existing Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Using the Open Command – 24
Using the Open Recent Command – 25
Using the Open Several Command – 26
Using the Open Selection Command – 27

Using Stationery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
Making Backups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28

Automatic Backups – 29
Manual Backups – 29

Printing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .30
Options Available from Print Dialog – 31
The Printing Options Command – 31

Launching BBEdit Lite
To launch BBEdit Lite, double-click the BBEdit Lite application icon or 
a BBEdit Lite document. Holding down the following keys at launch 
has the indicated effects, overriding any options set in the Startup 
panel of the Preferences. When one of these keys is held down, BBEdit 
Lite will beep after it finishes launching.

Startup Items
When launched, BBEdit Lite will look for a folder named Startup 
Items in the BBEdit Lite Support folder, which is in the same folder as 
the application. If this folder is found, BBEdit Lite will open any 
documents it finds in that folder. If the file is one BBEdit Lite knows 
how to open (such as a text file), BBEdit Lite will open a document 
window appropriate for the file.

Modifier(s) Function

Option Suppress startup items only

Shift Disable all plug-ins, tools, external services, and 
startup items
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If you place other types of documents in this folder, BBEdit Lite will 
ask the Finder to open them. If you often edit HTML files, for instance, 
you may want to place an alias to your Web browser (or your visual 
HTML editor) in the BBEdit Lite Startup Items folder so that it will 
start up automatically whenever you run BBEdit Lite.

If you wish, you may place the actual Startup Items folder in any 
convenient location, create an alias to it, and place the resulting alias 
in the BBEdit Lite Support folder. Be sure to name the alias “Startup 
Items” so that BBEdit Lite can locate it.

Memory Considerations
BBEdit Lite uses system memory (often referred to as “temporary 
memory”) for documents and for most editing operations, so that you 
can open large files without having to increase BBEdit Lite’s memory 
partition. If you have a large document open, you may not be able to 
launch other applications until you close it.

You should increase BBEdit Lite’s memory partition only if you use 
third-party plug-ins which require more memory to load. These 
operations all use memory in BBEdit Lite’s application partition. A 
good starting point would be to add 500K to BBEdit Lite’s Preferred 
memory size, and in general, you should never need to add more than 
1000K.

Mac OS X Mac OS X deals with memory very differently than do previous versions of the 
Mac OS. On Mac OS X, you no longer need to set memory partitions on a 
per-application basis.

Creating and Saving New Documents
To create a new document window within BBEdit Lite, pull down the 
File menu and move to the New submenu:
18 Chapter 3: Working with Files



If you choose to create a new Text Document, BBEdit Lite opens an 
empty text window. “With selection” opens a new text window 
containing any text selected in the active document and having the 
same display font, saving you the trouble of copying and pasting it. 
“With clipboard” opens a new text window and automatically pastes 
the contents of the current clipboard into it.

When you want to save the new document you’ve created:

1 Choose the Save or Save As command from the File menu

 BBEdit Lite opens the Save As directory dialog.

Note This is the Mac OS 9 Navigation Services version of the Save As dialog. BBEdit 
Lite can also be configured to use the older Standard File dialogs by turning 
off the Navigation Services checkbox in the Application panel of the 
Preferences. (On Mac OS X, Standard File dialogs are not available, and this 
preference is disabled.) The two versions of the dialog work in basically the 
same way.

2  Give the file a name

3 Change any desired options (see below)

4 Click Save to save the file

Save As Options
BBEdit Lite’s Save As dialog is the standard Save dialog with a few 
additions.
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Save As Stationery
When this option is selected, BBEdit Lite saves the document as a 
stationery pad. When you later open this document, BBEdit Lite uses 
it as the basis of a new untitled document. The new document will 
inherit the contents and display settings of the stationery document, 
but BBEdit Lite will prompt you for a name when you save it.

Save Selection Only
When this option is selected, BBEdit Lite saves only the selected text.

Options Button
The Options button opens a dialog box that lets you specify how 
much state information BBEdit Lite saves with the file, what kind of 
line breaks to save, and what file type to use. See the next section on 
“File Saving Options” for more information.

File Saving Options
When you use the Save As command, the Option button opens a 
dialog box that lets you control how much state information is saved 
with the file, what file creator to use, and what kind of line breaks to 
use.

Setting the File Creator
The File Creator is the information stored with the files that tells the 
Finder which application created the file. The default creator is 
naturally BBEdit Lite, but you can choose other types from this pop-
up menu.

Note If you save a file with a file creator other than BBEdit Lite, double-clicking the 
document will launch the application that matches the selected file creator. If 
you don’t have that program installed, you might get an error message. You 
can still open it in BBEdit Lite by dragging it onto the BBEdit Lite application 
icon, or by using BBEdit Lite’s Open command.

You can add additional file types and set the default for this pop-up 
menu with the File Types panel of the Preferences.
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Saving State Information
The state information that BBEdit Lite can save with a file includes the 
placement of the window, the scroll bar position, the font and size of 
the text, etc. BBEdit Lite stores either MPW state information or 
BBEdit state information. The following table shows what information 
is saved:

You can choose which state information to save from the Save State 
pop-up menu in the Options dialog when you use the Save As 
command. 

New in 6 The default state format in BBEdit Lite 6.1 is MPW (in previous 
versions it was BBEdit Lite).

Setting the Line Breaks
The line breaks setting let you choose what kinds of line breaks BBEdit 
Lite writes when you save the file. Choose:

• Macintosh line breaks (ASCII 13) if you are using the file only 
on a Macintosh or will be sending it to another Macintosh user.

• Unix line breaks (ASCII 10) if the file resides on a Unix file 
server or if you’re sending it to someone who uses a Unix 
system.

• DOS line breaks (ASCII 13/10) if the file resides on a DOS or 
Windows file server or if you’re sending it to someone who 
uses a DOS or Windows system.

Using a setting other than Macintosh requires extra time and memory 
as BBEdit Lite converts line breaks. The memory required to convert 
line endings is equal to the size of the text in memory, plus one byte 
per line if you use the DOS conversion setting.

Mac OS X Under Mac OS 9 and earlier, almost all applications expect or require files 
formatted with Macintosh line breaks. However, many of the Unix tools 
supplied with Mac OS X require files to be formatted with Unix line breaks.

Information MPW State     BBEdit State

Window position and size • •

Font & Tab • •

Scroll bar setting • •

Current selection range • •

Printing options •

Text display options •
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Note Tenon Intersystems’ MachTen system applies special translations to files, 
depending on their file type, file creator type, and their contents. If a file is of 
type ‘BINA’, creator ‘MUMM’, MachTen assumes that the text in the file (if 
any) contains UNIX-style line endings, and so will not apply any translation. 
When you use the “MachTen” setting, BBEdit Lite will create ‘BINA’ files, so it’s 
important that you choose “Unix” line endings so that MachTen can translate 
the file contents correctly.

Saving as Unicode
Note These checkboxes are always disabled in BBEdit Lite. Unicode support 

is only available in the commercial version of BBEdit.
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Opening Existing Documents
There are several ways to open existing documents with BBEdit Lite.

• Double-click any file with a BBEdit Lite document icon.

• If BBEdit Lite is running, choose the Open, Open Several, Open 
Hidden, or Open Recent commands from the File menu.

• Select the name of a file in a BBEdit Lite editing window, then 
use the Open Selection command in the File menu.

• Drag a file’s icon to the BBEdit Lite icon or to an alias of the 
icon.

Note There’s a bug in the Finder that can cause Drag and Drop not to work if you 
try to drop icons onto an alias of BBEdit Lite. This behavior is usually triggered 
by moving BBEdit Lite to another disk or rebuilding your desktop. If this 
happens, throw away your alias to BBEdit Lite and make a new one.

BBEdit Lite can natively open files with type ‘TEXT’ and ‘PICT’. (Of 
course, you cannot edit PICT files in BBEdit Lite, but it will display 
them.) 

New in 6 If you have QuickTime installed, you can play movie files by opening 
them with BBEdit Lite. You can also have BBEdit Lite ask QuickTime 
to try to open non-text files (by selecting the appropriate setting in the 
Application panel of the Preferences dialog). BBEdit Lite can then 
open image files and sounds in their own windows, rather than 
displaying them as text. If this preference is not active, then BBEdit 
Lite will open the files in their “raw” condition as if they were text 
documents.
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Using the Open Command
To open a file with the Open command:

1 Choose Open from the File menu.

 BBEdit Lite displays the Open dialog box.

Note This is the Mac OS 9 Navigation Services version of the Open dialog. BBEdit 
Lite can also be configured to use the older Standard File dialogs by turning 
off the Navigation Services checkbox in the Application panel of the 
Preferences. (On Mac OS X, Standard File dialogs are not available, and this 
preference is disabled.) The two versions of the dialog work in basically the 
same way.

2 Select the file you want to open.

3 Change any desired options. (See below.)

4 Click Open to open the file.

Note If you are using a PowerBook, please be aware that there is a bug in 
Navigation Services which will cause the dialog to be dismissed without 
opening any of the selected files, if you press the Enter key instead of clicking 
on the Open button.
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You can use the following options when you open a file.

Show (or File Types) Pop-Up Menu
This pop-up menu lets you choose what kinds of files can be selected 
from the Open dialog. (Its title is either “Show” or “File Types”, 
depending on the version of the dialog you’re using.)

If you know a file contains text, but it doesn’t appear in this dialog 
box, it means that the Macintosh type of the file is not set to ‘TEXT’. 
This is sometimes the case with files received from other computers or 
downloaded from the Internet. Choose Any File from the File Types 
pop-up menu to open the data fork of any file as a text file.

Mac OS X Given that Mac OS X does not set the file type of any text file created 
by a Unix program to a useful value, you may find it useful to turn on 
the Map the File Name option in the Text Files: Opening panel of the 
Preferences window. With this preference turned on, BBEdit Lite will 
inspect the file’s name to see if it can determine whether the file is text 
or not. BBEdit Lite will apply the Internet control panel file name 
mappings. (See Chapter 10, “Preferences”, for more details.

LF Translation
When this option is selected, BBEdit Lite translates DOS or Unix line 
breaks when opening a file. Otherwise, BBEdit Lite leaves the original 
line breaks untranslated.

Using the Open Hidden Command

Mac OS X The Open Hidden command in the File menu presents a dialog with 
the same appearance and behaviors as the standard Open dialog, 
except that it shows invisible files (including, on Mac OS X, files 
whose names begins with a period.)

Using the Open Recent Command
The Open Recent hierarchical submenu contains a list of files you have 
opened recently. To open one of these files, choose it from the Open 
Recent submenu.
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Using the Open Several Command
The Open Several command lets you open more than one file at the 
same time. To open several files at once, hold down the Option key as 
you pull down the File menu and choose the Open Several command.

BBEdit Lite opens the Open Several dialog box. This dialog is very 
different in its Navigation Services and Standard File incarnations, so 
we will show both versions here.

The Navigation Services version of the dialog looks just like the 
single-file open. In fact, it is the same dialog—Navigation Services lets 
you open multiple files even if you don’t select Open Several. You can 
select multiple files by holding down the Shift key while you click the 
second and subsequent files. To deselect a file chosen by accident, 
Shift-click the unwanted file.
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In the Standard File version of the dialog, you accumulate the files to 
be opened into a second list on the right side of the dialog. Click the 
Add button to add the selected file to the open list, or click Add All to 
add all the listed files. If you add a file to the open list by accident, 
select it in the list and click Remove to remove it from the right side of 
the dialog. Click the Done button when you’ve selected the files you 
want to open.

In either case, you can choose the same options available in the single-
file open dialog.

Using the Open Selection Command
The Open Selection command lets you open a file that’s referenced in 
the text of a document. It is particularly useful for programmers to 
open #include files or any document referenced by another file.

To open a file whose name is referenced in the text of a document:

1 Double-click to select the file name.

If the name contains spaces, drag across it with the mouse instead.

2 Choose Open Selection from the File menu

If a suffix of the form “.x” follows the name, BBEdit Lite automatically 
expands the selection to include the suffix.

BBEdit Lite looks for the file first in the same folder as the file that 
contains the reference, then in any folders within that folder. If the 
name of the file is surrounded by angle brackets, BBEdit Lite starts its 
search in the folder that you specified in the File Search panel of the 
Preferences.

If BBEdit Lite can’t find the file, it displays a Choose Folder dialog that 
gives you a chance to find the file manually.

In some cases, there may be more than one file with the same name in 
the various folders BBEdit Lite looks in. Normally, BBEdit Lite opens 
the first one it comes to, then stops. If you want BBEdit Lite to find all 
the files that match the selected name, be sure to select the Find All 
Matches option in the File Search panel of the Preferences.

Open File by Name
If there is no selection, or there is no text editing view in the front 
window, Open Selection becomes Open File by Name. Choosing the 
command lets you specify a name for the file to be opened; BBEdit Lite 
will open it as described above for Open Selection. You may also 
specify that only the <…> folder specified in the Preferences should be 
searched for the file.
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You may use the following wildcards in the Open File by Name 
dialog, if you activate the Match Wildcards checkbox:

Using Stationery
Like most modern Macintosh programs, BBEdit Lite supports 
stationery pads. A stationery pad is a template document that, when 
opened, results in a new, untitled document with the content from the 
stationery file. In other words, you do not edit the stationery 
document itself, you use it as a starting point for a new document.

To create a stationery pad, click the Save As Stationery checkbox when 
saving the file from BBEdit Lite. Alternately, any document can be 
changed into a stationery pad in the Finder by clicking the Stationery 
Pad checkbox in the document’s Get Info window.

New in 6 You can create new documents from a stationery pad by opening the 
pad the same way you would open any other document.

Making Backups
BBEdit Lite can automatically make a backup copy of a document 
before saving it. You can also manually take a snapshot of a document 
at any time to make it easier to revert to previous versions.

Note BBEdit Lite 6.1 uses a new format for its backup preferences which is not 
readable by any previous version. If you open a document containing old 
backup preferences, these will be converted into the new format immediately 
upon opening.

BBEdit Lite names backup files with the same name as the original file 
and appends the date and a sequence number. For example, the first 
backup made on August 10, 1996 of “My Text File” would be named 
“My Text File (8-10-96)-1”. The name of the original may be shortened 
if the date and sequence number would make the name of the backup 
file longer than 31 characters.

New in 6 Versions of BBEdit Lite prior to 6.1 named backup files with dates separated by 
“/” (e.g. “My Text File (8/10/96)-1”). This has been changed to avoid conflicts 
with Unix file naming conventions.

Wildcard Meaning

? Any single character

* Any number of characters

# Any numeric character

\ Escapes one of the above. To enter a literal backslash, use \\.
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New in 6 The Text Files: Saving panel of the Preferences includes an option that 
allows you to specify the default backup options for new files and for 
files that do not have state information. (See Chapter 10 for more 
details.) You can override this default on a file-by-file basis, or 
manually back up a file at any time.

A document must be saved and named before you can set its backup 
options or make a backup manually.

Note If the file being backed up contains Projector version-control information, this 
information is removed from the copy.

Automatic Backups
To make automatic backups of a document, follow these steps:

1 Choose the Backup Options command from the File menu.

BBEdit Lite opens the Backup Options dialog box.

2 Specify the folder where you want BBEdit Lite to save the backups. 
You can choose the document folder, the preferred backup folder (set 
in BBEdit Lite’s Preferences), or some other folder. In the latter case, 
click Set or drag a folder icon from the Finder to the text box.

3 Select the Make Backup before Saving option.

BBEdit Lite will make a backup before you save the file. The backup 
will contain the previously saved version of the file.

4 Click OK.

Manual Backups
To make backups manually, follow the same steps above, but do not 
select the Make Backup before Saving option. To make a backup at any 
point, choose the Make Backup Now command from the File menu.

BBEdit Lite opens a standard directory dialog box so that you can 
change the location and the name of the backup file. The default folder 
is the folder you specified in the Backup Options dialog box and the 
default name is the standard backup name as described at the 
beginning of this section.
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Printing
To print a document, choose the Print command from the File menu. 
BBEdit Lite opens the print dialog box. The items at the top of the 
dialog are standard, provided by the driver. The four items at the 
bottom of the dialog are the BBEdit Lite options.

This dialog may look different if you are using a different printer. With 
current versions of the LaserWriter driver, for instance, the BBEdit 
Lite-specific printing options are on a “page” of their own, where they 
can be selected by a pop-up menu at the top of the dialog. The 
resulting dialog is shown below.

Note You set the default settings for most printing options in the Printing section of 
the Preferences.

To print one copy of the active document without opening the print 
dialog box, choose the Print One Copy command from the File menu. 
(Hold down the Shift key on your keyboard to see it.)
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Options Available from Print Dialog
You can set the following options from the print dialog box.

Font Button
Click this button to open a dialog box that lets you set the font, size, 
style, and tab settings to use while printing.

Use Document’s Font
When this option is selected, BBEdit Lite uses the document’s font 
when printing.

Fractional Widths
When this option is selected, BBEdit Lite prints proportionally-spaced 
fonts with better letter spacing. This option works only on PostScript 
printers.

Options Button
Click this button to open the Printing Options dialog box. See “The 
Printing Options Command” below.

Print Selection Only
When this option is selected, BBEdit Lite prints only the selected text.

The Printing Options Command
The Printing Options command in the Edit menu lets you further 
specify how BBEdit Lite prints your documents. You can set the 
defaults for most of these options in the Printing panel of the 
Preferences.

Note When creating a new document, or opening a text document which doesn’t 
have BBEdit Lite saved state, or with the “Printing Settings” switch turned off 
in the State preferences, BBEdit Lite will obtain the print options for the 
document from the preferences, just before printing. Thus, for these types of 
documents, you can use the Printing preferences to control behavior globally, 
instead of having to change print settings on a per-document basis. Note that 
if you change the options in the “Print…” dialog, the document settings will 
be divorced from the preferences.
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You can also open this dialog box by using the Options button in the 
main print dialog box.

Print Backwards
When this option is selected, BBEdit Lite prints documents last page 
first. This option is useful if you’re printing to a printer like the 
original LaserWriter that does not arrange pages in the proper order.

Frame Printing Area
When this option is selected, BBEdit Lite draws a frame around the 
printed text.

Print Page Headers
When this option is selected, BBEdit Lite prints the page number, the 
name of the file, and the time and date printed in a header at the top of 
each page.

Print Line Numbers
When this option is selected, BBEdit Lite prints line numbers along the 
left edge of the paper.

Print Two-Up
When this option is selected, BBEdit Lite prints two pages on one 
sheet of paper. Use this option to save paper.

1-Inch Gutter
When this option is selected, BBEdit Lite leaves a one-inch margin 
along the left edge of the paper. Use this option if you usually put 
your pages in three-ring binders.

Print Full Pathname
When this option is selected, BBEdit Lite prints the full path name of 
the file being printed in the header.
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Time Stamp
The Time Stamp options let you choose whether the date that appears 
in the header is the date that the file was last modified or the date that 
the file was printed.

Print Rubber Stamp
When this option is selected, BBEdit Lite prints a message in gray 
diagonally across the page. Use the pop-up menu to choose a font, and 
type the message in the text box. BBEdit Lite chooses the right sized 
font to print the message.

If your printer supports grayscale printing, BBEdit Lite prints the 
rubber stamp in gray, otherwise it is printed in outline style.

Note This feature is not supported by all printer drivers.
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C H A P T E R

4
Editing Text with
BBEdit Lite

This chapter describes the basics of editing text with BBEdit Lite, 
wrapping text, text manipulations, and file comparison.
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Basic Editing
BBEdit Lite behaves like most Macintosh word processors or text 
editors. Characters that you type in an active window appear at the 
insertion point, a vertical blinking bar. You can click and drag the 
mouse to select several characters or words, and the selected text is 
highlighted in black or in a color that you choose with the Color 
control panel (or the Appearance control panel under Mac OS 8.0 or 
later).

 Selected text in an inactive window appears framed in the highlight 
color:

If you select some text and then type, whatever you type replaces the 
selected text.

To delete selected text, press the Delete key, or choose “Clear” from 
the Edit menu. If you have a keyboard with a numeric keypad on it, 
you can press the “Clear” key on the keypad to delete the selected 
text.

In addition to clicking and dragging, you can use three selection 
commands in the Edit menu to select text.

You can then cut, copy, or perform any other action that affects 
selected text.

To select… Choose this from the Edit menu…

line containing the 
insertion point

Select Line

paragraph containing 
the insertion point

Select Paragraph

entire text Select All
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Note BBEdit Lite defines a paragraph as a block of text surrounded by blank lines 
(lines containing no characters other than tabs or spaces). The beginning and 
end of the document also mark the beginning and end of paragraphs.

Moving text
To move text from one place to another, follow these steps:

1 Select the text you want to move

2 Choose Cut from the Edit menu

BBEdit Lite removes the text from the window and stores it on the 
Clipboard.

3 Use the scroll bars to move to the new place for the text if necessary, 
then click to set the insertion point where the pasted text is to be 
inserted

4 Choose Paste from the Edit menu

You can Paste the contents of the Clipboard as many times as you 
want in any BBEdit Lite window or in any other application.

Pasting inserts the text stored on the Clipboard at the insertion point. 
If there is a selection, pasting replaces the selection with the contents 
of the Clipboard.

To place text on the Clipboard without deleting it, choose Copy from 
the Edit menu.

Tip To add selected text to the existing contents of the Clipboard, hold down the 
Shift key as you choose the Cut or Copy commands. When you hold down 
the Shift key, BBEdit Lite changes these commands to Cut & Append and 
Copy & Append.

Multiple Clipboards
New in 6 BBEdit Lite now supports six separate clipboards. Each time you use 

the Cut or Copy command, BBEdit Lite automatically switches to the 
next clipboard (wrapping back around to clipboard #1 after the sixth). 
This way, the last six things you copied or cut are always available for 
pasting—sort of a “clipboard history.”
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By default, the Paste command pastes text from the most recently-
used clipboard, so if you do nothing special, BBEdit Lite works just 
like any other Macintosh program. However, by using the Previous 
Clipboard command on the Edit menu, you can access the previous 
clipboard contents. Next Clipboard moves forward through the 
clipboard history. There are also buttons in the Clipboard window 
(below) that let you move back and forth through the clipboards.

Once you have selected a clipboard using one of these methods, the 
next Cut, Copy, or Paste command will use the clipboard you chose. 
(Subsequent Cut or Copy commands will advance to the next 
clipboard. Paste never advances automatically.)
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Drag and Drop
Another way to move text from one place to another is to use 
Macintosh Drag and Drop. To use Macintosh Drag and Drop, follow 
these steps:

1 Select the text that you want to move

2 Place the mouse pointer within the selected area

3 Click and hold down the mouse button

4 Drag the mouse pointer to the place you want to move the text to 
within the current window or another BBEdit Lite window

If you drag and drop text to another window, BBEdit Lite copies the 
text to that window without removing it from the original window.

In addition, you can drag and drop an item from the Finder onto an 
editing window in BBEdit Lite. If the item is a text file, then the file’s 
contents are inserted. If the item is a folder, then a listing of the item’s 
contents is inserted. If you hold down the Command key while 
dragging a folder, the path of the item is inserted instead.

Multiple Undo
BBEdit Lite provides the ability to undo multiple edits, one action at a 
time. The number of edits that may be undone is limited only by 
available memory. The practical limitation is determined by the extent 
of the edits and the amount of free memory.

The Undo command essentially reverses any change you may have 
made to the content of your file. Each action, which is generally 
punctuated by a mouse click, is one undo-able incident. So, for 
example, if you type the sentence “This is a Test.”, and then click to 
highlight the second capital “T” and replace it with a lowercase “t,” 
and then highlight the word “is” and click on the HTML tools to 
change the style of the word to bold, that’s three distinct actions.

In this example, you can select the Undo command once to reverse 
your action of inserting the bold tags. Selecting Undo again would 
change the lowercase “t” back to an uppercase “T”. A third Undo 
would eliminate the sentence altogether—untype it, as it were.

BBEdit Lite also supports multiple Redos. If you haven’t made any 
changes after performing an Undo, you can redo each action, in order, 
by selecting that command from the Edit menu, or typing Command-
Shift-Z. However, once you perform a new action, you cannot redo 
any actions that you undid before you made that change.
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Window Anatomy
BBEdit Lite windows have the same controls you’re familiar with 
from other Macintosh applications (for example, windows are 
resizable and zoomable, and have both vertical and horizontal scroll 
bars). Two additional features, which may be less familiar, are also 
included: the status bar and the split bar.

If you choose the Show Line Numbers and Show Cursor Position 
options, BBEdit Lite windows have additional elements. The next 
section, “Text Options,” discusses these additional elements.

The Status Bar
The status bar is a panel at the top of editing windows that contains 
buttons and pop-up menus that let you work with the text in the 
window. A small key icon at the top right of the status bar lets you 
show or hide the status bar.

Mac OS X Under Mac OS X, the status bar display is toggled by the button in the top 
right corner of the window, as shown below. 

If the window contains a document that has been saved to disk, the 
status bar contains the full path to the file and the last time the file was 
changed. If the file hasn’t been saved to disk, the status bar displays 
(New Document) instead of the file name.

New in 6 Windows in which the text view status bar isn’t adjacent to the window title 
bar (e.g. disk browsers and search results) no longer have a status bar control 
(on Mac OS 9 or Mac OS X), but do honor the global status bar preference, 
and you can use the “Text Options” dialog to show and hide the status bar on 
a per-window basis.
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The icons on the status bar are indicators, buttons, and pop-up menus 
that give you quick access to commonly-used functions. The following 
table explains each icon.

Icon Meaning

A solid diamond indicates the document has been modified. A 
hollow diamond means only the state of the document (window 
position, selection range, scrolling position, etc.) has changed.

 The pencil icon indicates that the document can be modified. If 
the pencil has a slash across it, the document cannot be 
modified because the file is read-only, the disk is locked, or the 
file is part of a source-control system project (such as Projector or 
CVS) and is checked out. If the file is not on a locked disk, you 
can click the pencil icon to toggle the document’s editability.

 The Text Options pop-up menu contains commands such as Soft 
Wrap Text and Show Invisibles that let you control how the text 
appears in the window.

 The File-pop-up menu contains commands that let you save the 
document, set line-break options, and specify what state 
information is saved.

 The Insert pop-up menu contains commands that let you insert 
the contents of files, folder listings, and page breaks.

 The Path pop-up menu displays the list of folders that contain 
the document. You can use this pop-up menu to open any of the 
folders along the path in the Finder.

 The Info button displays a dialog box that lists the number of 
characters, words, lines, and pages in the document. Clicking 
this button is the same as choosing the Get Info command from 
the Windows menu.

 The Document icon button represents the current document. 
Clicking this icon is the same as choosing Reveal in Finder from 
the Windows menu: it opens the Finder window that contains 
the document. You can also drag the document icon to any 
other application, or you can drag it to the Trash (which is the 
same as choosing Close & Delete from the File menu).

 The key control shows and hides the status bar when running on 
Mac OS 9 and earlier. (On Mac OS X, the status bar display is 
toggled by the button in the top right corner of the window.)
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The Split Bar
Every editing window has a split bar, a small black bar above the 
scroll bar, that lets you split the window into two panes. Splitting the 
window lets you edit a document in two places at the same time. Each 
pane is independently scrollable, and unlike previous versions of 
BBEdit Lite, scrolling the non-active split view no longer 
automatically changes view focus.

To split the window, drag the split bar some distance into the window 
and let go.

To return to a single-pane window, drag the split bar back to its 
original place near the top of the window. You can drag anywhere on 
the split bar, not just at the right end.

Tip Double-clicking the split bar unsplits a split window, or restores the last-used 
split position. If the window has never been split, the window is split 50-50. To 
force a 50-50 split for a previously-split window, you can Option-double-click 
on the split bar when it is closed.

Cursor Movement and Text Selection
BBEdit Lite gives you several ways to move the insertion point and 
change the selection. You can click and drag using normal Macintosh 
text selection techniques or you can use the various keys on the 
keyboard.
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Clicking
You can select text in an editing window in the normal Macintosh 
fashion, by clicking and dragging. Holding down the Shift key while 
clicking extends the selection.

Triple-clicking is the same as clicking in a line and then choosing the 
Select Line command in the Edit menu.

Holding the Command and Option keys as you click or double-click 
triggers special actions:

Holding down the Option key as you double-click on a word is the 
same as selecting the word and choosing Find in Reference in the 
Search menu.

New in 6 BBEdit Lite optionally allows you to select entire lines by clicking in 
the left margin of an editing window. Click and drag to select multiple 
lines. Double-click to select an entire paragraph; double-click and drag 
to select a range of paragraphs. A checkbox in the Text Editing 
preferences (not shown), labeled Allow Single-Click Line Selection, 
controls this behavior. If the checkbox is turned off, clicking in the left 
margin moves the insertion point to the beginning of the clicked line, 
as in previous versions of BBEdit Lite. Note that the line number bar, if 
displayed, is not part of the left margin.

Arrow Keys
Use the arrow keys to move the insertion point right, left, up, and 
down, and augment these movements with Command and Option:

No Modifier Shift

Click move insertion point extend selection

Double-click select word extend selection to word

Triple-click select line

Option Command Command + 
Option

Click Open URL

Double-click look up selected 
word in program-
ming reference

select word and 
search for next 
occurrence of the 
word

No Modifier Option Command

Up Up one line up one screen start of document 
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Holding down the Shift key extends the selection. For example, 
pressing Shift-Option-Right Arrow selects the word to the right of the 
insertion point.

If you’re used to a word processor or text editor that uses Command 
key combinations to page through your document, you may want to 
swap the meaning of the Option and Command keys:

1 Choose Preferences from the Edit menu to open the BBEdit Lite 
Preferences window

2 Select the Text Editing panel in the list at the left edge of the dialog 

3 Under the heading Exchange Command and Option Key Behavior 
when Moving, select either the Horizontal, Vertical or both settings as 
you prefer. When active, these settings will change the sense of the 
up- and down-arrow keys as follows:

When the Shift key is held down, the arrow keys behave as described 
in the table above, except that the selection range is extended to 
include the new placement of the insertion point. (This is the same 
effect as typing the arrow-key combination, and then holding down 
the Shift key and clicking at the original placement of the insertion 
point, or at the end of the original selection range.)

Down Down one line down one screen end of document

Left Left one character left one word start of line

Right Right one character right one word end of line

No Modifier Option Command

Up Up one line start of document up one screen

Down Down one line end of document down one screen 

Left Left one 
character

start of line left one word

Right Right one 
character

end of line right one word

No Modifier Option Command
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The Delete Key
The Delete key deletes the character to the left of the insertion point. If 
you’ve selected text, the delete key deletes all the text in the selection. 
You can use the Command and Option keys to modify the way the 
Delete key works:

Holding down the Shift key with the Delete key makes the Delete key 
work the same way as the Forward Delete key on Extended 
Keyboards. This feature is particularly useful on PowerBooks.

If you want to enable this feature:

1 Choose Preferences from the Edit menu to open the Preferences 
window

2 Select Text Editing from the list at the left edge of the dialog box

3 Select the Enable Shift-Delete check box

Note If you have activated the Horizontal setting for Exchange Command and 
Option Key Behavior as described in the previous section, then the effects of 
Command and Option shown in the table above will be reversed accordingly. 

Modifier Action

none deletes character to the left of the insertion point

Option deletes to the beginning of the word to the left of 
the insertion point

Command deletes to the beginning of the line

Command-Option deletes to the beginning of the document
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The Numeric Keypad
Most Macintosh keyboards have a numeric keypad on the right side. 
Normally, you use the keys on the keypad to enter numbers. If you 
prefer, you can use the numeric keypad to move the insertion point:

1 Choose Preferences from the Edit menu to open the Preferences 
window

2 Select Text Editing from the list at the left edge of the dialog box

3 Mark the Use Numeric Keypad for Cursor Movement checkbox

You can use the Shift key with the keys on the numeric keypad to 
extend a selection. You can use the Command and Option keys with 
the 2, 4, 6, and 8 keys as you would the arrow keys.

To change the behavior of the numeric keypad, hold down the Option 
key and press the Clear key at the upper left-hand corner of the 
numeric keypad. (This key is also labeled Num Lock on some 
keyboards.) This toggles the keypad between moving the cursor and 
entering numbers.

Go To Line Command
To move the insertion point to a specific line, use the Go To Line 
command in the Search menu. When you choose this command, 
BBEdit Lite opens the Go To Line dialog box.

Type the number of the line you want to move to and click Go To.

start of line

7
up

8
Scroll up

9

left

4
show selection

5
Right

6

end of line

1
down

2
Scroll down

3
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New in 6 The Go To Line command honors the “Use ‘Hard’ Line Numbering in Soft-
Wrapped Text Views” option in the Text Editing pane of the Preferences 
window.

Function Keys
If your keyboard has function keys, you can use the following key 
equivalents for cutting and pasting, to scroll, and to move the 
insertion point.

Note Holding down the Command and Option keys as you press the forward delete 
key deletes to the end of the document.

No Modifier Option Command Shift

F1 Undo Redo

F2 Cut Cut & Append

F3 Copy Copy & Append

F4 Paste

del forward delete delete to
end of word

delete to
end of line

Home scroll to top of 
document

move insertion 
point to start of 
document

End scroll to end of 
document

move insertion 
point to end of 
document

Pg Up scroll page up

Pg Dn scroll page down
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Text Options
You can use the Text Options command (formerly Window Options) 
to change the way BBEdit Lite edits text and the way it displays text 
and additional elements in its windows.

The Text Option dialog box is divided into two parts. The Editing 
options on the left control the way BBEdit Lite behaves while you 
type. The Display options on the right control the appearance of the 
BBEdit Lite window.

Tip You can change many of the text options through the Text Options pop-up 
menu (left) in the status bar.

Changes you make in the Text Options dialog box affect only the 
current window. To make changes for all new windows that you open, 
use the Editor Defaults and Status Bar sections of the Preferences 
window.

Editing Options
These options control the way BBEdit Lite behaves as you type text in 
the active document window. Changes you make here affect only that 
window. To change editing behavior in windows you open in the 
future, use the Editor Defaults section of the Preferences dialog in the 
Edit menu.

Auto Indent
When this option is selected, pressing Return automatically inserts 
spaces or tabs to indent the new line to the same level as the previous 
line.

Tip To temporarily invert the sense of the Auto Indent option, hold down the 
Option key as you press the Return key.
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Balance While Typing
When this option is selected, BBEdit Lite flashes the matching open 
parenthesis, brace, or bracket when you type a closing one. This 
option is useful when you use BBEdit Lite to edit source files to ensure 
that all delimiters are balanced.

Smart Quotes
When this option is on, BBEdit Lite automatically replaces straight 
quotes (" ') with typographer’s quotes (“ ” ‘ ’).

Tip To type a straight quote when this option is selected (or to type a 
typographer’s quote when the option is deselected), hold down the Control 
key as you type the " or ' key.

Note Smart quote marks should not be used in HTML documents, as they will not 
display correctly; you must use straight quotes, or entity codes, instead. We 
recommend leaving this option turned off if you edit HTML content or 
program code.

Smart Editing
When this option is on, BBEdit Lite extends word selections to include 
the space following a word. This option removes the extra space that 
would be left behind otherwise when deleting or Cutting a selection, 
and also ensures that words are “padded” with whitespace when 
pasted into running text.

Note If you mainly edit HTML content or program code, you may wish to disable 
this option.

Auto-Expand Tabs
When this option is selected, BBEdit Lite inserts an appropriate 
number of spaces when you type Tab, rather than inserting a Tab 
character.

Soft Wrap Text
When this option is selected, BBEdit Lite soft wraps the text in the file 
to the right margin that you choose: the Philip Bar, the window width, 
or a specific number of characters. The Philip Bar is a gray line in the 
status bar that indicates the right edge of the usable viewing area on a 
9-inch (classic Mac) monitor.

See “How BBEdit Lite Wraps Text” later in this chapter to learn how 
wrapping works in BBEdit Lite.

Display Options
These options control the way BBEdit Lite displays the text in the 
active document window. Changes you make here affect only that 
window. To change display characteristics for windows you open in 
the future, use the settings available in the Status Bar panel of the 
Preferences dialog.
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Status Bar
This option shows or hides the status bar in the active window. When 
this option is selected, two sub-options are available.

• The Philip Bar option shows or hides a thin gray line in the 
status bar.

• The Tab Stops option shows or hides tick marks in the status 
bar that indicate the tab stops in the window.

Tip On Mac OS 9 and earlier, click the key icon in document windows to show or 
hide the status bar without opening the Text Options dialog box. On Mac OS 
X, click the button in the top right corner of the window. 

Line Numbers
This option adds line numbers along the left edge of the window.

Cursor Position
Adds a panel at the bottom left frame of the window that displays the 
location (line and column) of the insertion point or the last-changed 
end of the selection range.

Show Invisibles
This option shows or hides non-printing characters in the window. 
Select this option when you want to see line breaks, tabs, and 
“gremlins” (other invisible characters). BBEdit Lite uses these 
symbols:

When the Show Invisibles option is selected, the Show Spaces sub-
option is available, letting you turn off the visually “noisy” spaces.

Symbol Meaning

∆ tab

◊ space

• non-breaking space

¬ line break

¶ page break

¿ other non-printing characters
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Font & Tabs
You can choose the font, font size, text style, and tab spacing for a 
window by choosing Font & Tabs from the Text menu. The Font & 
Tabs dialog, shown here, appears.

You can choose the desired font, font size and style using controls in 
this dialog. You can also tell BBEdit Lite how many spaces occur 
between each tab stop. The chosen display style will be used for all 
text in the window; BBEdit Lite does not support the use of selective 
text styles.

Note The changes you make here only affect the current document. This dialog’s 
settings will be saved with the document if you choose BBEdit State 
information when saving. To set the default font, size, style, and tab 
information for new documents (or for documents that don’t have a saved 
state), see the Fonts panel of the Preferences.

Text Transformation
BBEdit Lite provides several commands that transform text in useful 
ways. All of these commands are in the Text menu.

Balance
Locates the pair of parentheses, braces, brackets, or smart (curly) 
quotes that surround the insertion point or the current selection. If 
there are unmatched delimiters within this area, BBEdit Lite beeps. 
You can also double-click on a delimiter character to invoke this 
command.
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Exchange Characters
This command, formerly known as Twiddle, swaps two characters 
according to the following rules:

• If there is no selection and the insertion point is not at the 
beginning or end of a line or of the document, this command 
transposes the two characters on either side of the insertion 
point.

• If the insertion point is at the beginning of a line or document, 
this command transposes the two characters following the 
insertion point.

• If the insertion point is at the end of a line or document, this 
command transposes the two characters before the insertion 
point.

• If there is a selection, this command transposes the characters 
at either end of the selection.

If you hold down the Option key as you choose this command, 
Exchange Characters becomes Exchange Words. Exchange Words 
behaves like Exchange Characters, except that it acts on entire words, 
rather than individual characters.

Change Case
This command lets you change between upper and lower case 
characters, or capitalize word, line, or sentence starts. You can choose 
to change the text in the current selection or in the whole document. 
When you choose the Change Case command, the following dialog 
appears:
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The radio buttons let you choose how to change the case of the text. To 
limit the change to the selection, click the Selection Only option. The 
following table explains the function of each radio button in this 
dialog.

Shift Left and Shift Right
These commands indent or outdent the selected text by one tab stop. If 
you hold down the Shift key while choosing one of these commands, 
the selected text will be indented or outdented by one space instead of 
one tab stop.

New in 6 BBEdit Lite 6.1 will now entab and detab on-the-fly as you shift text. 
For example, if the selected text is indented one tab stop and you 
apply Shift Left One Space, the tab will be converted to spaces, and the 
text will be outdented one space. If you then apply Shift Right One 
Space, the spaces will be converted back to a single tab.

Add Line Breaks
This command, formerly named “Insert Line Breaks”, inserts a hard 
line break at the end of each line of text as displayed. If there is any 
text selected, only that text will have line breaks added; otherwise, line 
breaks will be added to the entire document. See “How BBEdit Lite 
Wraps Text” later in this chapter for more information.

Remove Line Breaks
This command, formerly named “Unwrap”, removes carriage returns 
and spaces between groups of text. Use this command to turn text that 
has hard line breaks into text that can be soft-wrapped. See “How 
BBEdit Lite Wraps Text” below for more information.

This button… Changes the text like this…

Upper Case Every character changes to upper case.

Lower Case Every character changes to lower case.

Capitalize Words The first character of every word changes to upper 
case, other characters remain unchanged.

Capitalize Sentences The first character or every sentence changes to 
upper case, other characters remain unchanged.

Capitalize Lines The first character of every line changes to upper 
case; the other characters remain unchanged.

Form Words The first character of every word changes to upper 
case; other characters change to lower case.

Form Sentences The first character of every sentence changes to 
upper case; other characters change to lower case.
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Rewrap Quoted Text
New in 6 Rewraps hard-wrapped text with Internet-style quoting, while 

retaining the quoting characters. In Internet messages, it is common to 
use the “>” symbol to indicate that part of a message is quoted from a 
message that’s being replied to. As a message gets batted back and 
forth in a discussion, the oldest bits of text will end up having several 
“>” symbols in front of them. Each line of text in the message has a 
carriage return at the end, making rewrapping the text to a different 
width somewhat problematic.

In this command, BBEdit Lite first extracts each chunk of quoted 
text—that is, successive lines of text with the same number of markers. 
The markers are temporarily removed and BBEdit Lite removes the 
hard line breaks in the text, forming it into a soft-wrapped paragraph. 
The text is then hard-wrapped according to the settings in the dialog, 
which are the same as for the Hard Wrap command (described later) 
and the quote markers are re-inserted.

Increase and Decrease Quote Level
Inserts or deletes a standard Internet quote character (“>”) from the 
selected hard-wrapped text, or on the current line if there is no 
selection.

Strip Quotes
Removes all Internet-style quoting from the selected hard-wrapped 
text, or from the entire document if there is no selection.

Hard Wrap
This command wraps long lines by inserting hard line breaks and can 
re-flow (fill) paragraphs if desired. See “How BBEdit Lite Wraps Text” 
below for more information.
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Zap Gremlins
This command removes or replaces non-printing characters. Use this 
command when you have a file that may contain extraneous control 
characters or “gremlins”.

The check boxes in the left half of the dialog box determine which 
types of characters the Zap Gremlins command affects, while the 
radio buttons determine what is done with gremlins that are found.

Filter Line Feeds
When this option is selected, Zap Gremlins converts as if the file were 
opened with LF Translation turned on.

Zap Non-ASCII Characters 
New in 6 When this option is selected, Zap Gremlins zaps all characters in the 

file which do not fall in the 7-bit or ASCII range. Examples of such 
characters include special Macintosh characters such as bullets (•) and 
typographer’s quotes (“ and ”, ‘ and ’), as well as all multi-byte 
characters. In general, such special characters are those that you type 
by holding down the Option key.

Zap Control Characters 
When this option is selected, Zap Gremlins zaps a specific group of 
invisible ASCII characters, also known as control characters. Control 
characters can cause compilers and other text-processing utilities to 
malfunction, and are therefore undesirable in many files.

The radio buttons in the bottom part of the dialog determine how the 
Zap Gremlins command zaps the offending characters. These options 
do not affect the line break characters that the Filter Line Feeds option 
filters.
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Zap Null (ASCII 0) Characters 
New in 6 When this option is selected, Zap Gremlins will zap all instances of the 

null character (ASCII 0). If nulls are present in a text file, they will 
cause grep searches to halt. They may also cause malfunctions in other 
external text-processing programs. If Zap Control Characters is 
selected, this option will be enabled automatically. It is included 
separately in case you wish to remove only nulls without affecting 
other control characters which may be present in a file.

Delete 
Removes the zapped character completely from the text. This option is 
useful if you are only interested in destroying gremlins, and you don’t 
care where they were in the text.

Replace with Code 
Replaces the gremlin character with an escaped hexadecimal code. 
The escape code is in the convention used by the C programming 
language and Apple’s Rez resource-description language: \0x 
followed by the character code in hexadecimal (base 16). This option is 
useful to identify both the value and location of gremlin characters. 
Later, you can search for occurrences of \0x to locate the converted 
characters. (Searching for the grep pattern of “\\0x..” will select the 
entire character code for easy modification or deletion.)

Replace with 
Replaces the gremlin with the character you type in the edit field next 
to the radio button. This option is useful for identifying the location of 
gremlins, but not their value.

Selection Only 
If this checkbox is marked, only the selection is processed. Otherwise 
gremlins will be zapped throughout the entire document.

Entab
Converts runs of spaces into tabs, according to the setting in the Font 
& Tabs dialog box. This transformation is useful when downloading 
text from a mainframe computer or on-line service, when the 
document uses spaces to line up columns of text. If you don’t use a 
monospaced font, columns usually won’t line up unless you Entab the 
text first.

Detab
Converts tabs into runs of spaces, according to the setting in the Font 
& Tabs dialog box. This command is useful when uploading text to a 
mainframe or on-line service that has no concept of tabs as column 
separators.
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Resolve URL
To resolve a URL (Uniform Resource Locator), place the insertion 
point anywhere in the URL and choose this command. BBEdit Lite 
examines the URL and launches the appropriate Internet helper 
application. If the URL is not valid, or the helper application can’t be 
found, BBEdit Lite beeps.

Tip You can also Command-click anywhere in a URL to resolve it, or Control-click 
to bring up the contextual menu and select Resolve URL from it.

Note Some Web browsers cannot resolve URLs if the request is sent when the 
browser is starting up. If your Web browser doesn’t properly resolve the URL, 
wait until the browser has finished starting up, and then try again.

Bare Bones Software gratefully acknowledges John Norstad for 
providing the URL parsing code.

How BBEdit Lite Wraps Text
BBEdit Lite wraps text one of two ways: soft wrapping or hard 
wrapping.

Soft wrapping is like the word wrapping found in most word 
processors. When the insertion point reaches a right margin as you 
type, the word processor automatically moves the insertion point to 
the beginning of the next line. You never need to type a carriage return 
at the end of a line, only to start a new paragraph. If you place the 
insertion point in the middle of a paragraph and start typing, the text 
reflows so that words that are pushed out beyond the right margin 
end up on the next line. Usually, you use soft wrapping when you’re 
editing memos, mail messages, and other prose. It is also useful for 
HTML documents. With soft wrapping, you generally don’t have to 
scroll the window horizontally to see all the text in the file.

Unlike soft wrapping, hard wrapping requires a carriage return at the 
end of every line. When soft wrapping is turned off, BBEdit Lite lets 
you type as far as you like on a line, and never automatically moves 
the insertion point to the beginning of the next line. You have to 
manually type a carriage return to start a new line. You usually use 
hard wrapping to write programs, tabular data, resource descriptions, 
and so on. With hard wrapping, each line of source code or data 
appears on its own line in the window, although you may have to 
scroll the window horizontally to see the entire line if it’s long.

Tip If you open a file in BBEdit Lite that appears to consist of a few very long lines, 
you should select the soft wrapping option for that file.
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This table summarizes the commands to soft wrap and hard wrap 
text. The sections that follow give you details about using the 
wrapping commands.

Users of older versions of BBEdit or BBEdit Lite will note that the 
Wrap while Typing option (which hard-wrapped text automatically 
by inserting a Return when you reach the right margin) has been 
relegated to the dustbin of history. It has been superseded by soft 
wrapping.

Soft Wrapping
To turn on soft wrapping for the active window do one of the 
following:

• Choose Soft Wrap Text from the text options pop-up menu 
(left) in the status bar

• Select the Soft Wrap Text option from the Text Options dialog 
box by choosing Text Options from the Edit menu

To specify the wrapping margin, use the Text Options command. You 
can have text wrap at the Philip bar, the edge of the window, or a 
specific character position.

To make soft wrapping the default for new windows, select the Soft 
Wrap Text option in the Editor Defaults panel of the Preferences. You 
can also use the settings in that panel to specify the default wrapping 
margin.

To “freeze” the current line endings and hard-wrap the text at the 
current soft wrapping settings, use the Add Line Breaks command to 
insert a carriage return at the end of each line.

To do this… Do this…

Soft wrap text as you type Choose Soft Wrap Text from the text 
options pop-up menu (left) or select 
the Soft Wrap Text option from the 
Text Options dialog

Convert hard-wrapped text to soft-
wrapped text

Use the Remove Line Breaks 
command in the Text menu, and 
activate soft wrapping

Convert soft-wrapped text to hard-
wrapped text

Use the Add Line Breaks command in 
the Text menu

Hard wrap text to a specific margin, 
reflowing paragraphs as needed

Use the Hard Wrap command in the 
Text menu
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New in 6 While BBEdit Lite prefers to break lines at white space when soft 
wrapping, lines will now be broken as close as possible to the 
designated wrap width if they do not contain any white space. This 
way, long URLs and other extended strings of characters are visible 
without scrolling horizontally.

Soft Wrapping and Imported Text
In most cases, files that were created by the SimpleText or TeachText 
applications should be soft wrapped when you open them in BBEdit Lite.

Exporting Soft Wrapped Text
BBEdit Lite will not insert hard line breaks into Unix or DOS-format 
files upon saving, although versions of BBEdit prior to 4.5 did.

Soft Wrapping and Line Numbers
New in 6 A new preference, Use “Hard” Line Numbering in Soft-Wrapped Text 

Views, controls the way line numbers are displayed when you use soft 
wrapping. If this option is turned on, the line number bar, cursor 
position display, and “Go To Line” commands in editing views will 
use line numbers that correspond to “hard” carriage returns in the 
document, rather than to soft-wrapped line breaks. To restore the 
behavior of previous versions of BBEdit Lite, turn this preference off.

Hard Wrapping
The easiest way to hard wrap text is to type a carriage return 
whenever you want to start a new line. If the file you’re editing is a 
program (where long lines are normal in some languages), it’s best to 
turn off soft wrapping altogether.

To turn off soft wrapping for the active window, do one of the 
following:

• Choose Soft Wrap Text from the text options pop-up menu in 
the status bar

• Deselect the Soft Wrap Text option from the Text Options 
dialog box by choosing Text Options from the Edit menu

To turn off soft wrapping for new windows, deselect the Soft Wrap 
Text option in the Editor section of the Preferences.

BBEdit Lite provides two ways to convert soft-wrapped text into hard-
wrapped text. The first is a simple technique that uses a single 
command. The second way is a bit more complicated but gives you 
much more control over wrapping.
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Hard Wrapping Soft-Wrapped Text
To convert soft-wrapped text to hard-wrapped text, use the Add Line 
Breaks command in the Text menu. This command inserts a carriage 
return at the end of every line of the text as it appears in the window. 
If your wrapping margin is the edge of the window, you will get 
different results depending on the width of the window.

Note The Add Line Breaks command does not turn off soft wrapping.

Hard Wrapping and Filling Text
The Hard Wrap command in the Text menu gives you more flexibility 
over hard wrapping text than the Add Line Breaks command. While 
Add Line Breaks merely freezes the line breaks as they appear in the 
editing window, the Hard Wrap command lets you specify a 
wrapping margin, apply the command to the selection only, and 
reflow paragraphs.

When you choose the Hard Wrap command, BBEdit Lite opens this 
dialog box:

The controls on the left half of the dialog control how much of the text 
is hard wrapped, and the maximum length of lines after hard 
wrapping. The controls on the right side of the dialog control how this 
command deals with paragraphs.

The Selection Only option limits the effect of the command to the 
selected text. If this option is not selected, the command affects the 
entire contents of the window. The Limit buttons let you specify the 
wrapping margin.

If the Paragraph Fill option is selected, BBEdit Lite forms the lines into 
paragraphs before wrapping the lines. An example is the best way to 
illustrate this option.
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Start with this text:

This is what happens when you wrap to 65 characters with Paragraph 
Fill off: 

BBEdit Lite breaks the long line at the 65-character right margin 
(twice, because the line was so long) and leaves the short lines alone.

This is what happens to the same text when you wrap with Paragraph 
Fill on:

BBEdit Lite joins all the lines together to form a paragraph, then wraps 
the text to the 65-character margin.

The Paragraph Indentation buttons let you indent paragraphs after 
they’ve been wrapped.

• Flush Left does not indent paragraphs at all.

• First Line Only indents the first line by one tab stop. The rest of 
the paragraph is flush against the left edge of the window.

• All Lines indents all lines in the paragraph by one tab stop.

• Reverse Indent places the first line in the paragraph flush 
against the left edge of the window, and will indent all other 
lines in the paragraph by one tab stop.
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• Same As First Line indents all lines to the same indentation as 
the first line of the selection or document.

Mark the Relative to First Line checkbox to make any paragraph 
indents relative to the original indent of the first line of the selection or 
document. If you want paragraph indents to be relative to the left 
margin of the document, make sure this checkbox isn’t marked.

Click the Hard Wrap button to perform the Hard Wrap command. 
Click the Don’t Wrap button to save the settings without changing the 
text.

Tip If you hold down the Option key as you choose the Hard Wrap command, 
BBEdit Lite uses the last Hard Wrap settings to perform the operation, without 
displaying a dialog box.

The Insert Submenu
In addition to typing, you can use the commands in the Insert 
submenu of the Edit menu to insert text into the active window. These 
commands, which are also available on the Insert menu in the 
document status bar, let you insert the contents of other files, folder 
listings, Macintosh Toolbox templates, and page break characters.

Inserting Files
The Insert File command inserts the contents of a file into the 
document you’re editing. When you use this command, BBEdit Lite 
opens a directory dialog box that lets you select the file to insert. 
BBEdit Lite inserts the file at the insertion point or replaces the 
selected text.

Tip You can also use the File command on the Insert pop-up menu in the status 
bar, or drag a file’s icon from the Finder into a BBEdit Lite editing window, to 
insert the contents of that file.

Inserting a Folder Listing 
The Insert Folder Listing command inserts a textual listing of a folder 
hierarchy. When you use this command, BBEdit Lite displays a 
directory dialog box that lets you select a folder to insert. BBEdit Lite 
inserts the folder listing at the insertion point or replaces the selected 
text.

Tip You can also use the Folder Listing command on the Insert pop-up menu in 
the status bar to insert a folder listing.

You can also drag a folder’s icon from the Finder into a BBEdit Lite editing 
window to insert a folder listing.
62 Chapter 4: Editing Text with BBEdit Lite



Inserting Paths

New in 6 The Insert File Path and Insert Folder Path commands respectively 
insert the full path information for a selected file, or the full path 
information for the contents of the selected folder hierarchy into the 
document you’re editing. When you use these commands, BBEdit Lite 
opens a directory dialog box that lets you select the file or folder to 
obtain path information for. BBEdit Lite inserts the path information at 
the insertion point or replaces the selected text.

Inserting a Page Break
To insert a page break, choose the Page Break command from the 
Insert submenu in the Edit menu. This will place a form-feed character 
(ASCII 12) at the location of the insertion point. BBEdit Lite uses this 
character to indicate the start of a new page when printing.

Tip You can also use the Page Break command on the Insert pop-up menu in the 
status bar to insert a page break.
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C H A P T E R

5
Working with Windows

This chapter describes the commands in the Window menu. These 
commands let you arrange windows, get to windows quickly, and 
open special kinds of windows.

In this chapter
Window Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .65
Window List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
Arrange  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
Get Info  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68
Reveal in Finder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68
Send To Back  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69
Exchange With Next . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69
Synchro Scrolling . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69
Window Names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .69

Window Menu
New in 6 The Window menu contains commands which you can use to access 

and organize your documents on screen. It also provides many utility 
and reference functions. For BBEdit Lite 6.1, we have added several 
preference options (in the Applications panel of the Preferences 
dialog) so that you have greater control over the arrangement of the 
menu. You can now choose whether items are grouped by window 
kind, or are all listed together without dividers. You can also elect to 
sort windows by name or in order of creation. Please refer to Chapter 
10 for additional details.

Minimize Window

Mac OS X This command puts the frontmost window into the Mac OS X Dock. 
Click the window icon in the Dock to restore the window. If you are 
not using Mac OS X, this command will not be available on the menu.

Bring All to Front

Mac OS X In Mac OS 9 and earlier, each application’s windows are all grouped 
together in a single layer. In Mac OS X, windows from different 
applications can be interspersed. BBEdit Lite’s Bring All to Front 
command will bring all un-minimized BBEdit Lite windows to the 
front. If you are not using Mac OS X, this command will not be 
available on the menu.
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Window List

The Window List command opens a floating window (or floater) that 
lists the names of all the open windows, either in order by name or 
creation order, or separated by window kind as determined by your 
preferences (see Chapter 10).

Document windows, which correspond to text files, will have a 
document icon shown next to them. Display windows, such as 
browsers and search results windows, will not have icons next to 
them, A diamond to the left of a window’s name means that the file 
has been modified.

To bring any window to the front, double-click its name in the 
Windows window.

You can open a file by dragging its icon from the Finder to the 
Windows floater.

The buttons at the top of the Windows window perform Save, Close, 
or Print commands on the selected windows. Pressing the Option key 
while clicking a button makes its command apply to all selected 
windows (for which the command is possible).

Arrange
New in 6 The Arrange command gives you several ways to organize BBEdit 

Lite windows. When you choose the Arrange command, BBEdit Lite 
opens the Arrange Windows dialog box.

The radio buttons at the top of the dialog specify which screen the 
windows will be arranged on. You can choose the main screen, the 
largest screen, or the smallest screen.

Icon Description

Stacks every window so that some part is visible no 
matter which window is frontmost. If you select the 
Leave Room for Finder options in the Windows 
section of the Preferences dialog, BBEdit Lite leaves 
room along the right side or bottom of the screen 
for Finder icons.

BBEdit Lite offers three different ways to stack 
windows: down and to the left, straight down, and 
down and to the right. These are the top three 
choices in the dialog.

BBEdit Lite tiles the windows in two or three rows 
(or columns). If you have more than three windows 
open, BBEdit Lite stacks additional windows behind 
the three front windows.
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Tip To arrange the windows using the same settings as the last time you used this 
command, hold down the Option key as you choose Arrange from the 
Window menu.

New in 6 BBEdit Lite is now Display Manager aware. If you change the size of a 
screen which contains floating palettes, BBEdit Lite will reposition the 
palettes to take the new screen size into account (this may entail 
resizing the window as well).

BBEdit Lite figures out how many rows and columns 
it needs to tile windows. The larger your screen, the 
more rows and columns BBEdit Lite uses. The 
windows are never narrower than half of a classic 
Macintosh screen.

BBEdit Lite tiles the front two window horizontally 
or vertically and stacks any additional windows 
behind the two front windows.

Icon Description
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Get Info
The Get Info command displays a dialog box that lists the number of 
characters, words, line, and pages in the selected text and in the 
document. Using this command is the same as clicking the info button 
in the status bar.

To find out how many pages the document will take to print, click the 
Paginate button. To put the full path to the file on the Clipboard, click 
the Copy Path button.

Reveal in Finder
If the active window is a document that is saved in a file, the Reveal in 
Finder command opens the Finder window that contains this file. 
Using this command is the same as clicking (without dragging) the 
document icon button in the status bar. (The actual icon in the icon bar 
is the same as the document’s icon in the Finder.)

If the selected text in a document is the name of a file, hold down the 
Option key as you open the File menu and choose the Reveal Selection 
command to have BBEdit Lite open the Finder folder that contains 
that file.

Zoom
There is no longer a Zoom command on the Window menu, but the 
key equivalent Command-/ (which users of earlier versions of BBEdit 
Lite may be used to) still works. Zoom will produce the same effect as 
clicking a window’s zoom box: it makes the active window larger if it 
is small, or returns it to its original size if it was previously enlarged 
by a Zoom command.

When zooming windows, BBEdit Lite will now move the window as 
little as possible (consistent with maximizing the window’s size). This 
behavior is similar to what the Finder does when zooming a window. 
The “Move as Little as Possible” switch in the Windows preference 
panel controls this behavior; turning this switch off will revert the 
behavior to be the same as previous versions of BBEdit Lite.

Note If you have Apple Guide installed on your system, it will “steal” this keystroke, 
and the Apple Guide help window will appear instead.
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Send To Back
This command sends the front window behind all the other windows.

Exchange With Next
This command makes the second window the active window. Choose 
this command repeatedly to alternate between the front two windows.

Synchro Scrolling
When you have two or more windows open, Synchro Scrolling makes 
both files scroll when you scroll one. This feature is useful to look over 
two versions of the same file.

Window Names
The last items in the Window menu are the names of all the open 
windows. Choose a window name from this menu to bring that 
window to the front.

Tip You can also use the Windows floater to select windows quickly.
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C H A P T E R

6
Searching

This chapter describes BBEdit Lite’s powerful Find command, now 
enhanced with a flexible file filtering mechanism. It tells you how to 
search for text in the active window or within a set of files. BBEdit Lite 
can also do advanced pattern, or grep, searching. To learn about 
pattern searching, you should read this chapter first, then read 
Chapter 7, “Searching with Grep”.

In this chapter
Basic Searching and Replacing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72
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Basic Searching and Replacing
This section describes the basic steps for searching and replacing text 
in a window. Later sections in this chapter cover more advanced 
techniques. To search and replace text in the active window, follow 
these steps:

1 Choose Find from the Search menu. BBEdit Lite opens the Find & 
Replace dialog box.

For now, disregard the bottom part of the dialog—the Multi-File 
Search checkbox and everything below it. The section “Multi-File 
Searching” later in this chapter discusses this part of the dialog box.

2 Type the string you’re looking for in the Search For text box.

You can use special characters in the Search For text box to search for 
tabs, line breaks, or page breaks. See “Special Characters” later in this 
section.

BBEdit Lite remembers the last 12 search terms you used since 
launching the application. If you are searching for something you 
recently searched for, you can choose it from the pop-up menu above 
the Search For field.

Click the § button to enter the document selection in the Search For 
field.

3 Type the replace string (if any) in the Replace With text box.

BBEdit Lite also remembers the last 12 replace terms you used since 
launching the application. These appear on the pop-up menu above 
the Replace With field.

Click the § button to enter the document selection in the Replace With 
field.
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4 Mark any checkboxes in the middle part of the dialog box that you 
want to apply to your search. To learn more about these checkboxes, 
see “Search Settings” next in this section.

5 Click one of the buttons along the right side of the dialog box.

New in 6 The size of both the search and replace strings is now limited only by available 
memory. However, the memory requirements for searching multi-byte text 
files are generally at least double those for single-byte text.

The following table explains what each of the buttons does.

BBEdit Lite closes the Find dialog, then selects the search string in the 
active window if the search was successful. Once BBEdit Lite finds 
your text, you can use the commands in the Search menu (see “Search 
Menu Reference” later in this chapter). The table below summarizes 
the most common commands you can use at this point. 

This button… Does this…

Find Finds the first occurrence of the text in the active 
window. Shortcut: Cmd-F

Find All Finds all the occurrences of the search string and 
displays the results in a search results window.
Shortcut: Cmd-Opt-F

Replace If there is a selection, replaces the current selection
with the replace string. Otherwise, finds the
first occurrence of the text in the active window after 
the current insertion point and replaces it with the 
replace string. Shortcut: Cmd-R

Replace All Replaces every occurrence of the search string in the 
active window with the replace string.
Shortcut: Cmd-Opt-R

Don’t Find Saves the settings of the Find dialog box without doing 
a search. Shortcut: Cmd-D

Cancel Doesn’t do the search and restores the settings of the 
dialog box to their previous state. Shortcut: Cmd-.

This command… Does this…

Find Again Finds the next occurrence of the search string 
without displaying the Find dialog again. To 
reverse the search direction, hold down Shift.

Replace Replaces the selection with the replace text

Replace All Replaces all occurrences of the search string with 
the replace string.

Replace & Find Again Replaces the selection with the replace string and 
looks for the search string again.
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Search Settings
The checkboxes in the Find dialog box let you control how BBEdit Lite 
searches your document for the indicated text.

Note You can set the defaults for many of these settings in the Text Search section 
of the Preferences.

Use Grep
When this checkbox is selected, BBEdit Lite treats the search and 
replace strings as Grep patterns. Otherwise, BBEdit Lite searches the 
document for text that matches the search string as it appears literally, 
and will replace any matched text with the replace string. To learn 
more about pattern searching see Chapter 7, “Searching with Grep”.

Start at Top
When this checkbox is selected, BBEdit Lite always starts searches 
from the beginning of the document. Choosing this option will disable 
the Wrap Around and Search Backwards settings.

Wrap Around
When this checkbox is selected, BBEdit Lite continues searching from 
the beginning of the document if a match isn’t found (or from the end 
of the document if searching backwards). Otherwise, BBEdit Lite stops 
searching when it reaches the end (or the beginning if searching 
backwards) of the file. Choosing this option will automatically disable 
Selection Only. (Unavailable if Start at Top is checked.)

Search Backwards
When this checkbox is selected, BBEdit Lite searches from the 
insertion point to the beginning of the file. Otherwise, BBEdit Lite 
searches from the insertion point to the end of the file. (Unavailable if 
Start at Top is checked.)

Search Selection Only
When this checkbox is selected, BBEdit Lite searches only the selected 
text. Otherwise, BBEdit Lite searches the entire document. 
(Unavailable if Wrap Around or Start at Top is checked.)

Extend Selection
When this checkbox is selected, BBEdit Lite extends the selection from 
the current insertion point to the end of the matched search string.

Case Sensitive
When this checkbox is selected, BBEdit Lite treats upper- and 
lowercase letters as different letters. Otherwise, BBEdit Lite treats 
upper- and lowercase letters as if they were the same.
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Match Entire Words
When this checkbox is selected, BBEdit Lite matches the search string 
only if it is surrounded in the document text by word-break characters 
(white space or punctuation). Otherwise, BBEdit Lite matches the 
search string anywhere in the text.

Multi-File Search
When this checkbox is selected, BBEdit Lite searches a set of files for 
the search string. See “Multi-File Searching” below to learn more 
about searching in several files.

Batch Find
When this checkbox is selected and you’re doing a multi-file search, 
BBEdit Lite collects all the matches into a search results window. To 
learn more about multi-file searching, see “Multi-File Searching” later 
in this chapter.

Exclude Matches
When this checkbox is selected and you’re doing a multi-file search, 
BBEdit Lite finds all the files that don’t contain the search string rather 
than the files that do.

Special Characters
You can use the following special characters to search for line breaks 
and other non-printing characters, as well as hexadecimal escapes to 
search for any desired 8-bit character.

New in 6 The form of a hex escape is “\xNN”, where “N” is any single hex digit 
[0-9,A-F]. The “x” may be upper or lower case.

Note that because of limitations in BBEdit Lite’s grep engine, you can’t 
perform a Grep search for a null character (ASCII 0), even if it’s 
escaped. However, you can perform a literal search for any character, 
including a null. Malformed escapes (or a null escape, if using Grep) 
are treated as literal strings.

Character Matches…

\r line break (carriage return)

\n Unix line break (line feed)

\t tab

\f page break (form feed)

\xNN hexadecimal character code NN (e.g. \x0D for CR)

\\ backslash (\)
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Multi-File Searching
The only difference between single-file searching and multi-file 
searching is that in multi-file searching you need to specify the files to 
be searched. BBEdit Lite gives you a great deal of flexibility in how to 
do this. You can search all the files in a given directory, in open editing 
windows, or in a BBEdit Lite results window. 

To look for a string in several files, do the following steps:

1 Choose Find from the Search menu to open the Find & Replace dialog 
box (if it’s not already open).

2 Mark the Multi-File Search checkbox.

3 Type the string you’re looking for in the Search For text box.

4 Type the replace string (if any) in the Replace With text box. Be sure to 
read the section “Multi-File Replacing” later in this chapter if you use 
the replacement features.

5 Mark any checkboxes in the middle part of the dialog box that you 
want to apply to your search. To learn more about these settings, see 
“Search Settings” earlier in this chapter.

6 To have BBEdit Lite collect the results of the search in a search results 
window, select the Batch Find checkbox. Otherwise, BBEdit Lite 
searches for the search string file by file.

7 If you want BBEdit Lite to find only files that do not contain the search 
string, select the Exclude Matches checkbox.
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8 Use the controls in the bottom part of the dialog to specify the set of 
files to search. See “Specifying the Search Set” later in this chapter to 
learn more about doing this.

9 Click one of the buttons along the right side of the dialog box to begin 
the search.

The table below tells you what each of the buttons does.

If you selected the Batch Find option, read the following section 
“Multi-File Search Results: Batch Find”. If you did not, read the 
section “Multi-File Search Results: File by File” below.

This button… Does this…

Find Batch Find on: Not available when the multi-file search 
option is selected.

Batch Find off: Finds the first occurrence of the search 
string in the first file of the set.

Find All Finds all the occurrences of the search string in all the 
files in the set.

Batch Find on: BBEdit Lite displays the results in a 
search results window.

Batch Find off: BBEdit Lite opens all files that contain 
matches.

Replace Not available when the multi-file search option is 
selected.

Replace All Finds all the occurrences of the search string in all the 
files in the set and replaces them with the replace 
string.

Don’t Find Saves the settings of the Find dialog box without doing 
a search.

Cancel Doesn’t do the search and restores the settings of the 
dialog box.
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Multi-File Search Results: Batch Find
If you selected the Batch Find option, BBEdit Lite displays every 
occurrence of the search string in the set of files searched using a 
search results browser.  

New in 6 The items at the top of the window tells you how many matches 
BBEdit Lite found in the set of files you specified, as well as specifying 
whether there were any error conditions or warnings generated 
during the search. You can display or hide any combination of errors, 
warnings, and matches, by checking the appropriate options.

New in 6 The middle panel lists each line that contains the matched text. 
(Depending on how you have configured BBEdit Lite, this list may be 
a Finder-style hierarchical list, where each match in a file is listed 
under the file’s name as shown above, or a flat list where each 
occurrence is simply displayed in order.) Every match is identified by 
file name and line number.

To see the contents of a file, click a line in the list of matched searches. 
The part of the file that contains the search string appears in the lower 
pane. You cannot edit text in a search results browser. To edit a file, 
double-click the line that contains the match you want to edit, and the 
specified file will open at the point where the associated match 
occurred.

After you have opened a file, you can use the Find Again, Replace, 
Replace All, and Replace & Find Again commands in the Search menu 
to continue searching it, as if you had chosen a File by File search. See 
the next section for information on File by File searching.

Tip You can use a search results window as the basis of another multi-file search. 
See “Specifying the Search Set” later in this chapter.
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Multi-File Search Results: File by File
If you did not select the Batch Find option, BBEdit Lite opens the first 
file that contains the search string. At that point you can use the 
commands in the Search menu to further control the search.

Specifying the Search Set
When the Multi-File Search option is selected, the controls in the 
bottom part of the dialog box let you specify which files BBEdit Lite 
should consider in the multi-file search. 

The pop-up menu just below the Multi-File Search checkbox controls 
which files BBEdit Lite should search. You can search:

•  all open text documents
• the files in a given folder
• the files listed in any results browser (e.g. a search results 

browser)
Some of the other options change depending on what you select from 
this pop-up menu.

This command… Does this…

Find Again Finds the next occurrence of the search string 
within the same file. To search backwards, hold 
down the Shift key.

BBEdit Lite beeps if it can’t find any more 
occurrences of the search string in the current file. 
Use the Find in Next File command.

Replace Replaces the selection with the replace string.

Replace All Replaces all occurrences of the search string with 
the replace string within the current file.

Replace & Find Again Replaces the selection with the replace string and 
looks for the search string again.

BBEdit Lite beeps if it can’t find any more 
occurrences of the search string. Use the Find in 
Next File command.

Find in Next File Looks for the search string in the next file in the 
set of files to be searched.

Find & Replace
All Matches 

Replaces every occurrence of the search string 
with the replace string in each of the files being 
searched. See “Find & Replace All Matches” in the 
“Search Menu Reference” section at the end of 
this chapter.
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Searching the Files in a Folder
To search the files in a folder:

1 Choose Folder from the Search Type pop-up menu.

2 Choose a folder from the second pop-up menu.

New in 6 This pop-up menu displays up to 12 recently-used folders, as well as 
the folder you have designated as the local root of your Web site (if 
any), the folder you have designated as your Templates/Includes 
folder, and any favorite folders you have designated (see Chapter 2).

If the folder you want to search isn’t in the pop-up menu, choose 
Other and select the folder using the Open dialog, or click the Other 
button on the right-hand side of the dialog. You can also drag a folder 
from the Finder to the box that displays the path of the chosen folder.

3 To search folders within the folder you chose, click on the Options 
button and select the Search Nested Folders option in the Multi-File 
Search Options dialog. You can also choose to skip any folders whose 
names are enclosed in parentheses here by selecting the Skip (…) 
Folders option, and you can specify whether to search only text files 
or all files.

Searching the Results of a Previous Multi-File Search
If a multi-file search finds many files that contain your search string, 
you may want to narrow the search. You can do this if you selected the 
Batch Find option to do the initial search and the results are in a search 
results window. 

Note As mentioned above, you can also search the list of files presented in any 
results browser, not just search results browsers.

To narrow a search based on the results of an earlier search:

1 Choose Results Window from the Search Type pop-up menu.
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2 Choose the desired search results window from the Search Target 
pop-up menu (the second menu).

The Search Target pop-up menu defaults to the frontmost search 
results window. If you have more than one open, you can choose 
another from the menu. 

Searching All the Open Documents
You can limit the set of files to be searched to the open editing 
windows. One advantage of this kind of multi-file search is that you 
can search windows that haven’t been saved to a file yet.

To search all the open windows, choose Open Documents from the 
Search Type pop-up menu. The text box below the pop-up menu tells 
you how many windows will be searched.

Multi-File Search Options
Click the Options button to display the Multi-File Search Options 
dialog, shown here.

To search all the files in subfolders of the selected folder, mark the 
Search Nested Folders checkbox. The Skip (…) Folders checkbox skips 
folders whose names are enclosed in parentheses.

You can also choose to search only text files or to search all file types. If 
you have graphics or other types of files in the search set, it may be a 
good idea to restrict the search to only text files. This setting is in 
addition to any file filter (see next section) and is in fact applied before 
the filter.

Multi-File Replacing
If you want to replace only some occurrences of text in multiple files, 
you can simply do a File-by-File or Batch Search as described earlier in 
this chapter, then use the Replace commands on the Find menu to 
change only the instances you want to change. However, BBEdit Lite 
can also change all occurrences of a string in a group of files with one 
command. 
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Globally replacing text in more than one file works the same as 
replacing it in a single file.  The only possible complication is that, if 
you make a mistake, it can have much wider consequences. If you are 
not sure what effect a replace operation will have, test it out on a few 
sample files, or a copy of your data, first!

Note The Batch Find option has no effect on a multi-file replace operation.

To do a multi-file search and replace, replacing all occurrences:

1 Set up the find and replace strings in the Find dialog as described in 
the section “Multi-File Search”.

2 Choose the files to be searched as described in “Specifying the Search 
Set”.

3 Click Replace All in the Find dialog box, or use its key equivalent of 
Command-Option-R.

 BBEdit Lite displays the Find & Replace All Matches dialog box:

   This is what each of the options does:

This option… Replaces all occurrences of the search string 
with the replace string and…

Leave Open Leaves all the files open so that you can inspect the 
replacements.

If there are many files that contain the search string, 
BBEdit Lite may run out of memory.

Save to Disk Saves each file with the changes.

When the Confirm Saves setting is active, you will have 
an opportunity to approve the changes before BBEdit 
Lite saves them to disk. You should not turn this off 
unless you are sure that the replace operation being 
done is what you want.

Show Results Opens a results browser listing each of the files which 
was changed, and the number of changes in each file.
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Replacing in Files with Projector CKIDs
New in 6 In order to track the modification status of files and determine 

whether a given file is editable at any point in time, MPW’s Projector 
source control system places a resource of type “ckid” in each file. 
Many other Mac applications, including BBEdit Lite, also honor these 
“ckid” resources. This allows Projector (or similar systems like Mac 
CVS) to work, by preventing files from being changed accidentally.

During a multi-file replace, whenever BBEdit Lite attempts to modify 
a file which is designated Read-Only, it will display the following 
dialog asking you how to handle the file.

Choosing the Cancel button will stop the multi-file replace operation 
and leave the current file untouched. Choosing the Skip button will 
cause BBEdit Lite to skip this file only (leaving it untouched), and 
continue the multi-file replace operation. Choosing the MRO & 
Update button will cause BBEdit Lite to mark the file Modify Read-
Only, change the file, and continue the multi-file replace operation. 

If you select the Don’t Ask Again option before clicking Skip or MRO 
& Update, then BBEdit Lite will apply the same action to all files with 
this Projector state that it encounters during this (and only this) search 
operation. 

Note An equivalent dialog will also be displayed when you perform any other batch 
operation that modifies files, and a file with a Read-Only “ckid” is 
encountered.
Multi-File Replacing 83



Search Menu Reference
This section describes all of the commands in the Search menu.

Find
Opens the Find dialog box. You can set the search and replace strings, 
choose searching options, and, for a multi-file search, specify the set of 
files to search.

Find Again
Uses the previous settings of the Find dialog box to search for the next 
occurrence of the search string.

Tip Hold down the Shift key to search in the opposite direction from the current 
search direction. For example, if you have set the Backwards option in the 
Find dialog, holding down Shift while performing a Find Again will search 
forward in the document.

Find Selection
Uses the selected text as the search string and finds the next 
occurrence of the selected text. This command is the same as using the 
Enter Search String command followed by the Find Again command.

Tip Hold down the Shift key to search in the opposite direction from the current 
search direction, just as for Find Again.

Tip Hold down the Option and Command keys as you double-click on a word to 
search for the next occurrence of that word.

Enter Search String
Enters the selected text in the Find dialog as the search string (without 
opening the dialog) but does not search for it.

Tip When you hold down the Option key this command becomes Enter Replace 
String, and behaves identically except that it enters the selected text as the 
replace string.

Replace
Replaces the selected text (usually an occurrence of the search string) 
with the replace string.

Replace All
Replaces every occurrence of the search string in a file with the replace 
string.
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Replace & Find Again
Replaces the selected text with the replace string and searches for the 
next occurrence of the search string.

Find in Next File
When doing a non-batch multi-file search, this command looks for the 
first occurrence of the search string in the next file.

Open All Matches
This command opens all the files in the search set that contain at least 
one occurrence of the search string.

Find & Replace All Matches
In a multi-file search-and-replace for which Batch Find is turned off, 
this command finds every occurrence of the search string in every file 
in the search set and replaces them with the replace string. When you 
choose this command, BBEdit Lite opens a dialog that gives you an 
opportunity to approve replacements.

Go to Line
When you choose this command, BBEdit Lite opens the Go To Line 
dialog box. Type in a line number and the frontmost text window will 
jump to display that line.

New in 6 The Go To Line command honors the “Use ‘Hard’ Line Numbering in Soft-
Wrapped Text Views” option in the Text Editing pane of the Preferences 
window.

Go to Center Line
Will move the insertion point to the beginning of the middle or center 
line of the displayed text.
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C H A P T E R

7
Searching with Grep

The Grep option in BBEdit Lite’s Find command offers a powerful 
way to make changes to your data that “plain text” searches simply 
can’t. Grep patterns, also known as regular expressions, allow you to 
find, and change, text which matches a set of conditions that you 
specify. Combined with the multi-file search and replace features 
described in Chapter 7, BBEdit Lite’s grep capabilities can make many 
editing tasks quicker and easier, whether you are modifying Web 
pages, extracting data from a file, or just re-arranging a phone list.

For example, suppose you have a list of people’s names that you want 
to alphabetize. If the names appear last name first, you can easily put 
these names in a BBEdit Lite window and use the Sort Tool. But if the 
list is arranged first name first, a simple grep pattern can be used to 
put the names in the proper order for sorting—as you’ll see in this 
chapter.
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What is Grep or Pattern Searching?
A grep pattern, also known as a regular expression, describes the text 
that you’re looking for. For instance, a pattern can describe words that 
begin with C and end in l. A pattern like this would match “Call”, 
“Cornwall”, and “Criminal” as well as hundreds of other words.

In fact. you’ve probably already used pattern searching without 
realizing it. The Find dialog box’s “Match Case” and “Entire Word” 
options turn on special searching patterns. Suppose that you’re 
looking for “corn”. With the “Match Case” option turned off, you’re 
actually looking for a pattern that says: look for a C or c, O or o, R or r, 
and N or n. With the “Entire Word” option on, you’re looking for the 
string “corn” only if it’s surrounded by white space or punctuation 
characters; special search characters, called metacharacters, are added 
to the search string you specified to indicate this.

What makes pattern searching counterintuitive at first is how you 
describe the pattern. Consider the first example above, where we want 
to search for text that begins with the letter “C” and ends with the 
letter “l” with any number of letters in between. What exactly do you 
put between them that means “any number of letters”? That’s what 
this chapter is all about.

Note Grep is the name of a frequently-used Unix command that searches using 
regular expressions, the same type of search pattern used by BBEdit Lite. For 
this reason, you’ll frequently see regular expressions called “grep patterns,” as 
BBEdit Lite does. They’re the same thing.

Recommended Books and Resources

Mastering Regular Expressions
by Jeffrey E.F. Friedl. O’Reilly & Associates, 1997. ISBN 1-56592-257-3

Although it does not cover BBEdit Lite’s grep features specifically, 
Mastering Regular Expressions is an excellent resource for learning the 
“how-to” of writing useful grep patterns.

BBEdit-Talk
The BBEdit Lite-Talk online mailing list covers a wide range of topics 
and questions about using BBEdit Lite, which frequently include 
searching and the use of grep patterns. To subscribe to this list, please 
visit the support section of our Web site, which offers the option to 
sign up.

http://www.barebones.com/support/lists.html

Tech Note For the curious reader, BBEdit Lite’s grep engine is a variant of Henry Spencer’s 
regexp package, and its behavior is that of a ‘traditional NFA’ engine.
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Writing Search Patterns
This section explains how to create search patterns using BBEdit Lite’s 
grep syntax. (For readers with prior experience, this is essentially like 
the syntax used for regular expressions by the Unix egrep utility, with 
some borrowing from Perl.)

Most Characters Match Themselves
Most characters that you type into the Find dialog box match 
themselves. For instance, if you’re looking for the letter “t”, Grep stops 
and reports a match when it encounters a “t” in the text. This idea is so 
obvious that it seems not worth mentioning, but the important thing 
to remember is that these characters are search patterns. Very simple 
patterns, to be sure, but patterns nonetheless.

Escaping Special Characters
In addition to the simple character matching discussed above, there 
are various special characters that have different meanings when used 
in a grep pattern than in a normal search. (The use of these characters 
is covered in the following sections.)

However, sometimes you will need to include an exact, or literal, 
instance of these characters in your grep pattern. In this case, you 
must use the backslash character \ before that special character to 
have it be treated literally; this is known as “escaping” the special 
character. To search for a backslash character itself, double it \\ so that 
its first appearance will escape the second.

For example, you might need to re-arrange a list of labels which 
contains numbered items written like this: #1, #2, #3. As described in 
the next section, if you used the character # in your grep pattern, it 
would match any of the digits following the number sign, but not the 
number sign itself. So, you would need to write \# as part of your 
search pattern, to indicate that you want to match a literal number sign 
character rather than using its special meaning.
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Wildcards Match Types of Characters
These special characters, or metacharacters, are used to match certain 
types of other characters:

Being able to specifically match text starting at the beginning or end of 
a line is an especially handy feature of grep. For example, if you 
wanted to find every instance of a message sent by Patrick, from a log 
file which contains various other information like so:

From: Rich, server: barebones.com
To: BBEdit Lite-Talk, server: lists.barebones.com
From: Patrick, server: example.barebones.com

you could search for the pattern:

^From: Patrick

and you will find every occurrence of these lines in your file (or set of 
files if you do a multi-file search instead).

Character Classes Match Sets
or Ranges of Characters
The character class construct lets you specify a set or a range of 
characters to match, or to ignore. A character class is constructed by 
placing a pair of square brackets […] around the group or range of 
characters you wish to include. To exclude, or ignore, all characters 
specified by a character class, add a caret character ^ just after the 
opening bracket [^…]. For example:

Wildcard Matches…

. any character except a line break (i.e. a carriage return)

# any numeric character 0–9

^ beginning of a line (unless used in a character class)

$ end of line (unless used in a character class)

Character class Matches…

[xyz] any one of the characters x, y, z

[^xyz] any character except x, y, z

[a-z] any character in the range a to z
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You can use any number of characters or ranges between the brackets. 
Here are some examples: 

Note In BBEdit Lite 6.1 and later versions, character ranges are always treated as 
case sensitive regardless of the setting of the Case Sensitive option in the 
Find dialog.

A set pattern matches when the search encounters any one of the 
characters in the pattern. However, the contents of a set are only 
treated as separate characters, not as words. For example, if your 
search pattern is [beans] and the text in the window is “lima beans”, 
BBEdit Lite will report a match at the “a” of the word “lima”. 

To include the character ] in a set or a range, place it immediately after 
the opening bracket. To use the ^ character, place it anywhere except 
immediately after the opening bracket. To match a dash character 
(hyphen) in a range, place it at the beginning of the range; to match it 
as part of a set, place it at the beginning or end of the set.

Character class matches

[aeiou] any vowel

[^aeiou] any character that is not a vowel

[a-zA-Z0-9] any alphanumeric character

[^aeiou0-9] any character that is neither a vowel nor a digit

Character class matches

[]0-9] any digit or ]

[aeiou^] a vowel or ^

[-A-Z] a dash or A - Z

[--A] any character in the range from - to A

[aeiou-] a vowel or -
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Matching Non-Printing Characters
As described in Chapter 7 on searching, BBEdit Lite provides several 
special character pairs that you can use to match certain non-printing 
characters. You can use these special characters in grep patterns as 
well as for normal searching. 

New in 6 You can now also specify any character in a grep pattern by means of 
its hexadecimal character code (escape code). 

For example, to look for a tab or a space, you would use the set pattern 
[\t ] (consisting of a tab special character and a space character).

Use \r to match a line break in the middle of a pattern and the special 
characters ^ and $ (described above) to “anchor” a pattern to the 
beginning of a line or to the end of a line. In the case of ^ and $, the 
line break character is not included in the match.

Other Special Characters
BBEdit Lite also supports several Perl-like expressions for matching 
different types or categories of characters. 

Character Matches…

\r line break (carriage return)

\n Unix line break (line feed)

\t tab

\f page break (form feed)

\xNN hexadecimal character code NN (e.g. \x0D 
for CR)

\\ backslash

Special Character Matches…

\s any whitespace character (space, tab, carriage 
return, line feed, form feed)

\S any non-whitespace character (any character not 
included by \s)

\w any word character (a-z, A-Z, 0-9, _, and some 8-bit 
characters)

\W any non-word character (all characters not included 
by \w, including carriage returns)

\d any digit (0-9), same as #

\D any non-digit character (incl. carriage return)
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A “word” is defined in BBEdit Lite as any run of non-word-break 
characters bounded by word breaks. Word characters are generally 
alphanumeric, and some characters whose value is greater than 127 
are also considered word characters. 

Note that any character matched by \s is by definition not a word 
character; thus, anything matched by \s will also be matched by \W 
(but not the reverse!).

Repetition Metacharacters Repeat Other Patterns
The special characters *, +,  and ? specify how many times the pattern 
preceding them may repeat. The preceding pattern can be a literal 
character, a wildcard character, a character class, or a special character.

Note that the repetition characters * and ? match zero or more 
occurrences of the pattern. That means that they will always succeed, 
because there will always be at least zero occurrences of any pattern, 
but that they will not necessarily select any text (if no occurrences of 
the preceding pattern are present).

Try the following examples to see how their behavior matches what 
you expect:

Pattern Matches…

p* zero or more “p”s

p+ one or more “p”s

p? zero or one “p”s

Pattern Text is… Matches…

.* Fourscore and seven years Fourscore and seven years

[0-9]+ I’ve been a loyal member 
since 1983 or so.

1983

#+ I’ve got 12 years on him. 12

A* BAAAAAAAB advances the insertion point 
past the first and last “B”s,  
and matches “AAAAAAA”

A+ BAAAAAAAB AAAAAAA

A? Andy joined AAA the “A” from Andy

A+ Ted joined AAA yesterday “AAA” and the “a” from 
yesterday
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Combining patterns to make complex patterns
So far, the patterns you have seen match a single character or the 
repetition of a single character or class of characters. This is very 
useful when you are looking for runs of digits or single letters, but 
often that’s not enough.

However, by combining these patterns, you can search for more 
complex items. You’re already familiar with combining patterns. 
Remember the section at beginning of this discussion that said that 
each individual character is a pattern that matches itself? When you 
search for a word, you are already combining basic patterns.

You can combine any of the preceding grep patterns in the same way. 
Here are some examples.

Note again in these examples how the characters that have special 
meaning to grep are preceded by a backslash: \+, \., and \$. 

Also, as you can see from the last example, with a pattern which was 
intended to find dollar amounts, it’s not always possible to keep a 
pattern from matching unexpectedly.

Creating Subpatterns
Subpatterns provide a means of organizing or grouping complex grep 
patterns. This is primarily important for two reasons: for limiting the 
scope of the alternation operator (which otherwise creates an 
alternation of everything to its left and right), and for changing the 
matched text when performing replacements. A subpattern consists of 
any simple or complex pattern, enclosed in a pair of parentheses:

Pattern Matches Examples

#+\+#+ a string of digits, followed by 
a literal plus sign, followed by 
more digits

4+2
1234+5829

####[\t ]B\.C\. four digits, followed by a tab 
or a space, followed by the 
string B.C.

2152 B.C.

\$?[0-9,]+\.#* an optional dollar sign, 
followed by one or more 
digits and commas, followed 
by a period, then zero or 
more digits

1,234.56
$4,296,459.19
$3,5,6,4.0000
0. (oops!)

Pattern Matches…

(p) the pattern p and remembers it
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You can combine more than one subpattern into a grep pattern, or mix 
subpatterns and other pattern elements as you need. 

Taking the last set of examples, you could modify these to use 
subpatterns wherever actual data appears:

We will revisit subpatterns in the section on replacement, so that you 
can see how the choice of subpatterns affects the changes you can 
make.

Note Be careful when using subpatterns of the form (p)*, as it is possible to create 
an overflow condition for BBEdit Lite’s grep engine. BBEdit Lite now attempts 
to guard against this by stopping the search process if it detects a potential 
overflow; instead of crashing, the pattern should just fail to match. If you need 
to use this type of expression, we recommend using (p)+ instead. Or in 
particular, if you are trying to work around . not matching carriage returns, 
use [\s\S]* instead of (.|\r)*.

Pattern Matches Examples

(#+)\+(#+) a string of digits, followed 
by a plus sign, followed by 
more digits

4+2
1234+5829

(####)[\t ]B\.C\. four digits, followed by a 
tab or a space, followed by 
the string B.C.

2152 B.C.

\$?([0-9,]+)\.(#*) an optional dollar sign, 
followed by one or more 
digits and commas, 
followed by a period, then 
zero or more digits

1,234.56
$4,296,459.19
$3,5,6,4.0000
0.
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Using Alternation
The alternation operator | allows you to match any of several patterns 
at a given point. To use this operator, place it between one or more 
patterns x|y to match either x or y.

As with all of the preceding options, you can combine alternation with 
other pattern elements to handle more complex searches.

The ‘Longest Match’ Issue
When creating complex patterns, you should bear in mind that the 
repetition characters * and + are “greedy”. That is, they will always 
make the longest possible match possible to a given pattern, so if your 
pattern is E* (zero or more E’s) and your text contains “EEEE”, the 
pattern matches all the E’s at once, not just the first one. This is usually 
what you want, but not always.

Suppose, for instance, that you want to match an HTML tag. You’d 
think that a good way to do this would be to search for a pattern

<.+>

consisting of a less-than sign, followed by one or more occurrences of 
a single character, followed by a greater-than sign. To understand why 
this may not work the way you think it should, consider the following 
sample text to be searched:

<B>This text is in boldface.</B>

The intent was to write a pattern that would match both of the HTML 
tags separately. Let’s see what actually happens. The < character at the 
beginning of this line matches the beginning of the pattern. The next 
character in the pattern is . which matches any character (except a line 
break), modified with the + repetition operator, taken together, this 

Pattern Text is… Matches…

a|t A cat each “a” and “t”  

a|c|t A cat each “a”, “c”, and “t”  

a (cat|dog) is A cat is here. A dog is 
here. A giraffe is here.

“A cat is”, “A dog is”  

A|b+ Abba “A”, “bb”, and “a”  

Andy|Ted Andy and Ted joined 
AAA yesterday

“Andy” and “Ted”

####|years I’ve been a loyal 
member since 1983, 
almost 16 years ago.

“1983”, “years”

[a-z]+|#+ That’s almost 16 years. “That”, “s”, “almost”, 
“16”, “years”
96 Chapter 7: Searching with Grep



combination means one or more repetitions of any character. That, of 
course, takes care of the B. The problem is that the next > is also “any 
character” and that it also qualifies as “one or more repetitions.” In 
fact, all of the text up to the end of the line qualifies as “one or more 
repetitions of any character” (the line break doesn’t qualify, so grep 
stops there). After grep has reached the line break, it has exhausted the 
+ operator, so it backs up and sees if it can find a match for >. Lo and 
behold, it can: the last character is a greater-than symbol. Success!

In other words, the pattern matches our entire sample line at once, not 
the two separate HTML tags in it as we intended. More generally, the 
pattern matches all the text in a given line or paragraph from the first 
< to the last >. The pattern only does what we intended when there is 
only one HTML tag in a line or paragraph. This is what we meant 
when we say that * and + try to make the longest possible match.

To work around this behavior, you must modify your pattern to take 
advantage of additional context present in the data, if possible. 
Instead of matching multiple occurrences of any character, try to 
match any character other than the character that marks the end of the 
text you want to select. You can do this with the character range 
operator […] by including a ^ as the first character of the range to 
mean any character besides the indicated characters. For example:

<[^>]+>

…matches an opening bracket, then one or more occurrences of any 
character other than a closing bracket, followed by a closing bracket. 
This achieves the results you want, preventing BBEdit Lite from 
“overrunning” the closing angle bracket.

A slightly more complicated example: how could you write a pattern 
that matches all text between <B> and </B> HTML tags? Consider the 
sample text below:

<B>Welcome</B> to the home of <B>BBEdit Lite!</B>

As before, you might be tempted to write:

<B>.*</B>

…but for the same reasons as before, this will match the entire line of 
text. The solution is similar. We want the * character to stop repeating 
when it reaches the opening < of the </B> tag, so we tell it to match 
any character that’s not a <.

<B>[^<]*</B>

Note If there are any other tags between the <B> and </B>, this pattern will fail.
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Writing Replace Patterns

Subpatterns Make Replacement Powerful
We covered subpatterns earlier when discussing search patterns and 
discussed how the parentheses can be used to limit the scope of the 
alternation operator. Another reason for employing subpatterns in 
your grep searches is to provide a powerful and flexible way to 
change or re-use found information as part of a search-and-replace 
operation. If you do not use subpatterns, you can still access the 
complete results of the search with the & metacharacter. However, this 
precludes reorganizing the matched data as it is replaced. 

Using the Entire Matched Pattern
The & character is useful when you want to use the entire matched 
string as the basis of a replacement. Suppose that in your text every 
instance of product names that begin with the company name 
“ACME” needs to end with a trademark symbol (™). The following 
search pattern finds two-word combinations that begin with “ACME”:

ACME [A-Za-z]+

The following replacement string adds the trademark symbol to the 
matched text:

&™

For example, if you start with

ACME Magnets, ACME Anvils, and ACME TNT are all premium 
products.

and perform a replace operation with the above patterns, you will get:

ACME Magnets™, ACME Anvils™, and ACME TNT™ are all premium 
products.

Pattern Matches…

& the entire matched pattern [replacement only]

(p) the pattern p and remembers it [search only]

\1, \2, …, \9 the nth subpattern in the entire search pattern
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Using Parts of the Matched Pattern
While using the entire matched pattern in a replacement string is 
useful, it’s often more useful to use only a portion of the matched 
pattern and to rearrange the parts in the replacement string.

For example, suppose a source file contains C-style declarations of this 
type:

#define Util_Menu 284
#define Tool_Menu 295

and you want to convert them so they look like this, Pascal-style:

const int Util_Menu = 284;
const int Tool_Menu = 295;

The pattern to find the original text is straightforward:

\#define[ \t]+.+[ \t]+#+[^0-9]*$

This pattern matches the word “#define” followed by one or more 
tabs or spaces, followed by one or more characters of any type, 
followed by one or more tabs or spaces, followed by one or more 
digits, followed by zero or more characters that are not digits (to allow 
for comments), followed by the end of the line.

The problem with this pattern is that it matches the entire line. It 
doesn’t provide a way to remember the individual parts of the found 
string.

If you use subpatterns to rewrite the above search pattern slightly, you 
get this:

\#define[ \t]+(.+)[ \t]+(#+)[^0-9]*$

The first set of parentheses defines a subpattern which remembers the 
name of the constant. The second set remembers the value of the 
constant.

The replacement string would look like this:

const int \1 = \2;

The sequence \1 is replaced by the name of the constant (the first 
subpattern from the search pattern), and the sequence \2 is replaced 
by the value of the constant (from the second subpattern).

Our example throws out any comment that may follow the C-style 
constant declaration. As an exercise, try rewriting the search and 
replace patterns so they preserve the comment, enclosing it in (*…*) 
style Pascal comment markers.
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Here are some more examples:

Case Transformations

New in 6 Replace patterns can also change the case of the original text when 
using subpattern replacements. The syntax is the same as Perl, 
specifically:

Here are some examples to illustrate how case transformations can be 
used.

Given some text:

mumbo-jumbo

and the search pattern:

(\w+)(\W)(\w+)

the following replace patterns will produce the following output:

\U\1\E\2\3                MUMBO-jumbo

\u\1\2\u\3                Mumbo-Jumbo

Data Search for Replace Result

4+2 (#+)\+(#+) \1+\2 4+2

1234+5829 (#+)\+(#+) \1+\1 1234+1234

2152 B.C. (####)[\t ]B\.C\. \1 A.D. 2152 A.D.

1,234.56 \$?([0-9,]+)\.(#+) \1 dollars and 
\2 cents

1,234 dollars 
and 56 cents

$4,296,459.19 \$?([0-9,]+)\.(#+) \1 dollars and 
\2 cents

4,296,459 
dollars and 19 
cents

$3,5,6,4.00000 \$?([0-9,]+)\.(#+) \1 dollars and 
\2 cents

3,5,6,4 dollars 
and 00000 cents

Modifier Effect

\u Make the next character uppercase

\U Make all following characters uppercase until reaching 
another case specifier (\u, \L, \l ) or \E

\l Make the next character lowercase

\L Make all following characters lowercase until reaching 
another case specifier (\u, \U, \l ) or \E

\E End case transformation opened by \U or \L
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Note that case transformations also affect literal strings in the replace 
pattern:

\U\1\2fred                mumbo-FRED

\lMUMBLE\2\3              mUMBLE-jumbo

Finally, note that \E is not necessary to close off a modifier; if another 
modifier appears before an \E is encountered, then that modifier will 
take effect immediately:

\Ufred-\uwilma            FRED-Wilma

Examples
The example patterns in this section describe some common character 
classes and shortcuts used for constructing grep patterns, and 
addresses some common tasks that you might find useful in your 
work.

Matching Identifiers
One of the most common things you’ll use grep patterns for is to find 
and modify identifiers, such as variables in computer source code or 
object names in HTML source documents. To match an arbitrary 
identifier in most programming languages, you might use this search 
pattern:

[a-z][a-zA-Z0-9]*

This pattern matches any sequence that begins with a lowercase letter 
and is followed by zero or more alphanumeric characters. If other 
characters are allowed in the identifier, add them to the pattern. This 
pattern allows underscores in only the first character of the identifier:

[a-z_][a-zA-Z0-9]*

The following pattern allows underscores anywhere but the first 
character, but allows identifiers to begin with an uppercase or 
lowercase letter:

[a-zA-Z][a-zA-Z0-9_]*

Matching White Space
Often you will want to match two sequences of data that are separated 
by tabs or spaces, whether to simply identify them, or to rearrange 
them. 

For example, suppose you have a list of formatted label-data pairs like 
this:

User name: Bernard Rubble
Occupation: Actor
Spouse: Betty
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You can see that there are tabs or spaces between the labels on the left 
and the data on the right, but you have no way of knowing how many 
spaces or tabs there will be on any given line. Here is a character class 
that means “match one or more white space characters.”

[ \t]+

So, if you wanted to transform the list above to look like this:

User name("Bernard Rubble")
Occupation("Actor")
Spouse("Betty")

You would use this search pattern:

([a-z ]+):[ \t]+([a-z ]+)

and this replacement pattern:

\1\("\2"\)

Matching Delimited Strings
In some cases, you may want to match all the text that appears 
between a pair of delimiters. One way to do this is to bracket the 
search pattern with the delimiters, like this:

".*"

This works well if you have only one delimited string on the line. But 
suppose the line looked like this:

"apples", "oranges, kiwis, mangos", "penguins"

The search string above would match the entire line. (This is another 
instance of the “longest match” behavior of BBEdit Lite’s grep engine, 
which was discussed previously.)

Although you can specify which characters are allowed in delimited 
strings, it’s much easier to allow everything in the string except the 
delimiter.

The following pattern is much more effective for delimited strings:

"[^"]+"

This pattern allows anything except a delimiter (a double-quote in this 
case) as a match. (Of course, if the pattern contains an escaped quote 
(\"), grep will end it there instead.)

Note however that the pattern above works only on strings with 
single-character delimiters. If your strings use multi-character 
delimiters, you’ll need to use the first method. For example, this 
pattern matches C comments, in which * is perfectly valid:

/\*.*\*/
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Marking Structured Text
Suppose you’re reading a long text document that doesn’t have a table 
of contents, but you notice that all the sections are numbered like this:

3.2.7     Prehistoric Cartoon Communities
5.19.001  Restaurants of the Mesozoic

You can use a grep pattern to create marks for these headings, which 
will appear in the Marks pop-up menu.

First, decide how many levels you want to mark. In this example, the 
headings always have at least two digits and at most four.

Use this pattern to find the headings:

^(#+\.#+\.?#*\.?#*)[ \t]+([a-z ]+)

and this pattern to make the file marks:

\1 \2

The  ̂before the first search group ensures that BBEdit Lite matches 
the numeric string at the beginning of a line. The pattern

\.?#*

matches a (possible) decimal point and a digit sequence. The other 
groups use the white space idiom and the identifier idiom.

You can use a similar technique to mark any section that has a section 
mark that can be described with Grep.

Marking a Mail Digest
You can elaborate the structured text technique to create markers for 
mail digests. Assume that each digest is separated by the following 
lines:

From: Sadie Burke <sadie@burke.com>
Date: Sun, 16 Jul 1995 13:17:45 -0700
Subject: Fishing with the judge

Suppose you want the marker text to list the subject and the sender. 
You would use the following search string:

^From:[ \t]+(.*)\r.*\rSubject:[ \t]+(.*)

And mark the text with this replacement string:

\2 \1

Note that for the sequence \r.*\r in the middle of the search string, the 
\r before “Subject” is necessary because as previously discussed, the 
special character . does not match carriage returns.
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Rearranging Name Lists
You can use grep patterns to transform a list of names in first name 
first form to last name first order (for a later sorting, for instance). 
Assume that the names are in the form:

Junior X. Potter
Jill Safai
Dylan Schuyler Goode
Walter Wang

If you use this search pattern:

^(.*) ([^ ]+)$

And this replacement string:

\2, \1

The transformed list becomes:

Potter, Junior X.
Safai, Jill
Goode, Dylan Schuyler
Wang, Walter

Modifying HTML tags
When updating or editing Web page content, you may often want to 
replace or modify some of the existing markup, without changing the 
associated text content.

For instance, say you want to change every instance of the following 
markup, containing some arbitrary content:

<CENTER><H2><FONT COLOR=#0000FF> text</FONT></H2></CENTER><P>

by changing the heading level to <H3> and modifying the font color 
to #FF00FF, to produce the following result:

<CENTER><H3><FONT COLOR=#FF00FF> text</FONT></H3></CENTER><P>

Here is one way to approach the task. Start by searching for:

<CENTER><H2><FONT COLOR=\#0000FF>([^<]*)</FONT></H2></
CENTER><P>

and do a replacement with:

<CENTER><H3><FONT COLOR=#FF00FF>\1</FONT></H3></CENTER><P>

In this case, you first use strings to specify the exact tag format that 
you want to match, and then use a character range for the variable 
text. You must also check the tag strings to see if they contain any 
special grep characters, and if so, you must modify them accordingly. 
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One of the target tags does contain the color value  #0000FF, and as 
you know from previous sections, the number sign # is a special 
character in grep. So, you must escape this by placing a backslash 
ahead of it \# so that it will be interpreted literally. (Note that this is 
not necessary in the replace string, since that is not performing a 
match on anything, but it would work properly there as well.)

After the tag string, you then create a character range to hold the 
variable text content [^<]* by searching for zero or more instances of 
any character except another left angle bracket. You then enclose this 
expression in parentheses so you can refer to it again in the replace 
string.

The replace string consists of the revised tags, and a  \1  to insert the 
variable text content which was remembered by the subpattern that 
you defined above.

You need to keep in mind that this search pattern will not work if the 
variable text section itself contains markup, since you have specified 
that as containing any character except a tag opening character (left 
angle bracket). 

The simpler expression:

<CENTER><H2><FONT COLOR=\#0000FF>(.*)</FONT></H2></CENTER><P>

will avoid that issue; however, it has the disadvantage of not 
suppressing BBEdit Lite's longest match behavior, so any match will 
extend to the close of the furthest font tag possible (e.g. if there are two 
font tags per line in your source document).

As a second example, say that you want to locate every web URL in a 
file, and turn it into a link. (To keep things simple for now, let’s assume 
that all instances of these URLs are just surrounded by whitespace, 
with no parentheses, quotes, or other markers.) Since such a URL will 
always start with the specifier “http://”, you can use that as the basis 
for a search pattern:

(http://[\S]+)

Since the main part of a URL can contain most anything, except 
unencoded whitespace, you then specify a character range of [\S]+, 
for one or more instances of any character which is not whitespace. 
You should then place parentheses around the pattern, so that you can 
use the URL you’ve found as part of the replace pattern.

To complete the task, you can use a replacement pattern like the 
following:

<a href="\1">\1</a>

which opens an anchor tag, inserting the URL we just found as its 
target, and then inserts the same URL again as the visibly linked text 
between the opening and closing parts of the tag.
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C H A P T E R

8
Preferences

You can use the Preferences command to customize much of BBEdit 
Lite’s behavior. You can decide which windows are open when you 
launch BBEdit Lite, set the default options for windows, set the 
default options for searches, and so on. This chapter describes BBEdit 
Lite’s extensive Preferences options.
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The Preferences Command
To open the Preferences window, choose the Preferences command 
from the Edit menu.

The small text area at the top left of the window, next to the Revert and 
Save buttons, gives you a brief description of the contents of the 
currently displayed preferences panel.

The list along the left side of the window lets you select the 
preferences panel to be displayed.

To save your preferences, click Save. To have BBEdit Lite “back out” 
any changes you make while in the Preferences window, click Revert. 
Please note that Revert will only return settings which you have 
changed since the last Save operation to their saved condition; it does 
not restore default settings. In order to completely reset all preference 
settings to their default values, you must remove the active BBEdit 
Lite Prefs file from the BBEdit Lite Preferences folder. Chapter 2 
contains details about the organization of BBEdit Lite’s preferences 
files.

New in 6 Unlike previous versions of BBEdit Lite, the Preferences window in 
BBEdit Lite 6.1 is non-modal; you can leave it open as you work. It 
does not automatically close when you click Save or Revert. You can of 
course close it with the close box or by choosing Close from the File 
menu.

The following sections describe each of the preferences panels in 
detail.
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Application Preferences
New in 6 The Application preferences control which application and system 

services BBEdit Lite uses, how entries are sorted on the Window 
menu, when open files are verified, and various other global settings.

Optional Application Services

BBEdit Plug-ins
When this option is selected, BBEdit Lite makes the Tools menu 
available in the menu bar so that you can use BBEdit plug-ins (small 
add-on programs that add functionality to BBEdit Lite). BBEdit Lite 
plug-ins are stored in the BBEdit Lite Support folder. See Chapter 2 to 
learn more about the organization of the BBEdit Lite Support folder, or 
Chapter 15 for information about the standard plug-ins supplied with 
BBEdit Lite.

Internet Helpers Menu
When this option is selected, BBEdit Lite uses information provided 
by the Internet control panel to provide access to client software 
through the Internet Helpers menu (left). See the Additional Software 
section of Chapter 2 to learn more about Internet services.

Optional Mac OS Services

Navigation Services
If this checkbox is marked, BBEdit Lite uses the Navigation Services 
dialog when asking you to locate files and folders for opening and 
saving. Otherwise, BBEdit Lite uses the older Standard File dialogs. If 
you are running on an early-generation PowerMac, you may wish to 
turn this setting off for improved performance.
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Mac OS X Navigation Services is mandatory under Mac OS X, therefore, this checkbox is 
disabled when running on Mac OS X.

Appearance Manager
If this checkbox is marked, BBEdit Lite uses the Appearance Manager 
to draw windows and controls. If you are running on an early-
generation PowerMac, you may wish to turn this setting off for 
improved performance.

Mac OS X Appearance Manager support is mandatory under Mac OS X, therefore, this 
checkbox is disabled when running on Mac OS X.

QuickTime Translation
If you mark this checkbox, and have a recent version of QuickTime 
installed, BBEdit Lite will ask QuickTime if it recognizes any files that 
BBEdit Lite doesn’t. If QuickTime recognizes the file as one it can 
display, BBEdit Lite will open it for viewing; otherwise, the file will be 
opened as “raw” text.

QuickTime Playback
This checkbox controls whether BBEdit Lite opens QuickTime movies 
for playback in a movie window, or if it just opens them as text data in 
an editing window. The default is to recognize QuickTime movies and 
display them with a player. Changes to this preference take effect 
immediately.

Show Full Paths in “Open Recent” Menu
Mark this checkbox to show the complete pathname of recently-
opened files, rather than just their names, in BBEdit Lite’s Open 
Recent submenu. (If a recent file is missing, only its name will appear, 
regardless of this setting.)

Window menu

Show Full Paths
Mark this checkbox to show the complete pathname of open 
documents, rather than just their names, in BBEdit Lite’s Window 
menu.

Group by Window Kind
Mark this checkbox to group windows of the same kind together in 
the Window menu. For example, text editing windows, disk browsers, 
and search results browsers are all different kinds of windows. 

Within each group, windows will be sorted as determined by the Sort 
Windows By radio buttons to the right. If you turn the checkbox off, 
all windows are listed together, sorted as determined by the Sort 
Windows By radio buttons.
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Sort Windows by
Choose Name to sort windows alphabetically by name. Choose 
Creation Order to show the windows in the order they were created, 
or opened, in the current BBEdit Lite session.

Remember Dialog Box Placement
Mark this checkbox to have BBEdit Lite remember the location of the 
Find dialog, and most other dialogs between sessions. If you turn the 
checkbox off, BBEdit Lite will open dialogs at a default location every 
time you use them.

Browser Display Preferences
The Browser Display preferences control the initial appearance of 
BBEdit Lite’s built-in browsers for disks, search results, and so forth.

Results Lists
New in 6 For search results browsers, you can have BBEdit Lite either display 

an hierarchical listing (where all the matches associated with a 
particular file are grouped under that file, using disclosure triangles 
similar to those in the Finder’s list views to reveal or hide the match 
list), or a flat listing showing each individual match encountered on a 
separate line. In the latter case, you can also tell BBEdit Lite to expand 
all the file nodes initially, by checking Expand Listing. This preference 
also governs the default display of hierarchical or flat error listings in 
error browsers.
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Editor Defaults Preferences
The Editor Defaults preferences control the behavior of newly created 
document windows and documents without saved state information. 
Many of the preferences in this panel are the same as those in the Text 
Options dialog box and in the Text Options pop-up menu (left) in the 
status bar. The difference is that the Text Options control the behavior 
of the active window, while the Preference controls the behavior of 
new windows.

Note Many of the keyboard behavior settings formerly located in this panel have 
moved to the Text Editing panel.

Auto-Indent
When this option is selected, pressing the Return key in new windows 
automatically inserts spaces or tabs to indent the new line to the same 
level as the previous line.

Tip To temporarily invert the sense of the Auto Indent option while typing, hold 
down the Option key as you press the Return key.

Balance while Typing
When this option is selected, BBEdit Lite flashes the matching open 
parenthesis, brace, bracket, or curly quote when you type a closing 
one. This option is useful when editing source files to ensure that all 
delimiters are balanced.

Smart Quotes
When this option is on, BBEdit Lite automatically substitutes curly (or 
typographer’s) quotes (“ ” ‘ ’) for straight quotes (" ').
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Tip To type a straight quote when this option is selected (or to type a curly quote 
when the option is deselected), hold down the Option key as you type a 
single or double-quote.

Note You should avoid using Smart Quotes when editing HTML documents.

Smart Editing
When this option is on, BBEdit Lite extends word selection to include 
the space following a word. This option removes the extra space that 
would otherwise be left behind when performing a Cut or delete 
operation, and also selects trailing spaces when performing a word 
selection (e.g. by double-clicking).

Auto-Expand Tabs
When this option is selected, BBEdit Lite inserts an appropriate 
number of spaces instead of a tab character every time you press the 
Tab key.

Show Invisibles
This option shows or hides non-printing characters in the window. 
Select this option when you want to see line breaks, tabs, and gremlins 
(invisible characters). BBEdit Lite uses these symbols to represent non-
printing characters:

Show Spaces
If this setting is checked (and Show Invisibles is active), BBEdit Lite 
will display placeholder characters for spaces. Uncheck this option to 
suppress the display of spaces, which will reduce clutter when you’re 
displaying invisible characters.

Note Non-breaking spaces (typed by pressing Option-space) will not be displayed 
with a placeholder.

Symbol Meaning

∆ tab

◊ space

• non-breaking space

¬ line break

¶ page break

¿ other non-printing characters
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Soft Wrap Text
When this option is selected, BBEdit Lite soft wraps the text in the file 
to the right margin that you choose: the Philip bar, the window width, 
or a specific number of characters, as selected by the options below the 
checkbox.

Note The Philip bar is the light gray line in the status bar that indicates the right 
edge of the usable viewing area on a 9-inch (classic Mac) monitor.

Default Font
To choose the default font, font size, and tab stop spacing for a 
particular encoding, click Set Font & Tabs. The Font & Tabs dialog box, 
below, appears.

You can choose the desired font, font size and style using controls in 
this dialog. You can also tell BBEdit Lite how many spaces occur 
between each tab stop. Individual documents may override these 
settings if they contain appropriate state information. (See Chapter 3 
for more details on document states.) The settings you choose here are 
defaults which BBEdit Lite uses for new windows and for documents 
with no saved state information.
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File Search Preferences
The File Search preferences control the way BBEdit Lite searches for 
files when you use the Open File by Name or Open Selection 
commands from the File menu.

Find All Matches
When this option is selected, BBEdit Lite looks for all the files that 
match the entered or selected text. Otherwise BBEdit Lite stops 
looking as soon as it finds the first file that matches the selected name.

Skip (…) Folders
When this option is selected, BBEdit Lite does not search folders 
whose names are enclosed in parentheses.

Follow Folder Aliases
When this option is selected, BBEdit Lite follows folder aliases when 
searching for a file matching the specified name. Otherwise, BBEdit 
Lite ignores folder aliases and searches only regular folders. If the 
Follow to Remote Volumes option is on, BBEdit Lite will follow folder 
aliases even if the target folder is on a file server.

Note Using this option can substantially increase the length of time required to 
perform a search.
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Default <…> Directory
The text box displays the default path that BBEdit Lite uses to locate 
files whose names are enclosed in angle brackets when you use the 
Open File by Name or Open Selection commands. To change the 
default search directory, do one of the following:

• Click the Choose button and select the folder from the 
directory dialog box.

• Drag the icon of the folder to the path text box.

Note When running on Mac OS X, the default value for the Default <…> Directory 
setting is the current user’s login folder.

Unix Search Paths
Mac OS X The Unix Search Paths options are only available when using BBEdit Lite on 

Mac OS X.

These paths are designed to make it easier to work with Unix source 
code, which uses include statements of the form:

    #include <xxx/yyy.h>

A more concrete example: the canonical Unix include directory is 
“/usr/include”. It contains its own subdirectories, but since Unix 
command-line compilers don’t usually do recursive searches, you 
need to qualify the include file’s name if you want to include a file out 
of one of the subdirectories:

    #include <sys/ioctl.h>

With the new Unix Search Paths settings, you can now add “/usr/
include” to the list (actually, that’s one of the factory defaults). When 
you select “sys/ioctl.h” and choose “Open Selection”, BBEdit Lite 
attempts to construct a file path using each of the directories shown in 
the Unix Search Paths list. If one resolves to a file, BBEdit Lite will 
open the resulting file. Thus, the partially-qualified selection “sys/
ioctl.h” now resolves to

    /usr/include/sys/ioctl.h

and the file opens.
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File Types Preferences
The File Types preferences let you set the creator signatures of the files 
that BBEdit Lite can save. Entries in this part of the Preferences appear 
in the list of file types in the Options section of the Save As dialog.

When BBEdit Lite saves a new file, it sets the type of the file to ‘TEXT’ 
and usually sets the file’s creator to “R*ch”. You can choose a different 
creator by selecting it from the File Creator pop-up menu in the 
Options section of the Save As dialog.

The Find All button allows you to easily add all the applications you 
have that are capable of opening text files. This may be a long list, so 
you may prefer to add only the applications you actually use.

To set the default creator signature

1 Select an application from the list.

2 Click Make Default.

A check mark appears next to the default creator. When saving files, 
BBEdit Lite will save new files with this creator signature unless you 
choose a different one. When saving a file that already exists, BBEdit 
Lite never changes the creator.

To add a new application to the list

1 Click Add and select an application from the Open dialog box.

To delete an item from the list

1 Select an application from the list.

2 Click Remove.
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Startup Preferences
The Startup preferences control what BBEdit Lite does when you 
launch it, or when the application icon is double-clicked under Mac 
OS 8.0 or later and there are no open windows in BBEdit Lite (even if 
the application is already running).

Do Nothing
This option specifies that BBEdit Lite should not open any windows or 
perform any other actions.

New Text Document
This option specifies that BBEdit Lite should open a new, empty text 
editing window.

Open
This option specifies that BBEdit Lite should bring up the standard 
Open dialog, allowing you to select and open a file.

Open Several
This option specifies that BBEdit Lite should bring up the standard 
Open Several dialog, allowing you to select and open multiple files.

You can hold down the following modifiers during launch to override 
these actions.

Modifier(s) Function

Option Suppress startup items only

Shift Disable all plug-ins, tools, external services, and 
startup items
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State Preferences
New in 6 The State preferences control how BBEdit Lite reads and writes state 

information in text files.

Honor Saved State
When this option is selected, BBEdit Lite honors state information that 
may be stored in a file. The following sub-options let you fine tune 
which state information BBEdit Lite honors.

Window Position
When this option is selected, BBEdit Lite restores the window of the 
document to the same position as when the file was closed. Otherwise 
BBEdit Lite opens the window in its default position.

Font Settings
When this option is selected, BBEdit Lite restores the font information 
stored with a document. Otherwise it uses the default font settings.

Selection Range
When this option is selected, BBEdit Lite restores the insertion point or 
selection range to the same position as when the file was closed. 
Otherwise, the insertion point is at the beginning of the file.

Scrollbar Position
When this option is selected, BBEdit Lite restores the scroll bar 
position to the same position as when the file was closed. Otherwise, 
BBEdit Lite opens the file with the top of the file showing.
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Option Settings
When selected, BBEdit Lite reads document-specific options, such as 
soft wrap, show invisibles, and line numbering, from the saved state 
information.

Printing Settings
When this option is selected, BBEdit Lite restores the printing 
information stored with a document. Otherwise it uses the default 
printing settings.

Default Saved State
The Default Saved State setting lets you choose the kind of state 
information that BBEdit Lite saves when you save a file. You can 
choose to save no state information, MPW state information, or BBEdit 
state information. See the section on Saving State Information in 
Chapter 3 for more details on the different types of states.

Always Add State
When this option is selected, BBEdit Lite always adds state 
information when you save a file. Otherwise, BBEdit Lite saves state 
information only for files that already have state information.

Status Bar Preferences
New in 6 This preferences panel lets you choose which icons and pop-up menus 

appear in the status bar of BBEdit Lite document windows.

Show Status Bar
Mark this checkbox to display the status bar by default. (You can 
always show it or hide it independently for each window.)
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Show Philip Bar
Displays the Philip Bar, which represents the usable width of the 
screen on a 9-inch (“classic”) Macintosh monitor, in the status bar.

Show Tab Stops
Displays tab stops in the status bar, using the tab width set in the 
Editor section of the Preferences.

Show Line Numbers
This option displays line numbers along the left edge of the window.

Show Cursor Position
Adds a panel at the bottom left corner of the window that displays the 
location (line and column) of the insertion point, or the endpoint of a 
just-changed selection range (if the cursor has not been moved yet 
after the change).

Window Options
The Window Options pop-up menu allows you to set wrapping, 
display, and editing preferences for the current window, as with the 
Window Options command on the Edit menu.

File Options
This pop-up menu lets you save your file and set end-of-line and other 
compatibility options.

Insert Menu
The Insert pop-up menu lets you insert the contents of another text file 
(or a toolbox call template) into the current document.

File Path
The File Path displays the folder structure that contains the file being 
edited. You can choose any folder from this menu to open it in the 
Finder.

Get Info Icon
Click this icon to display the Info window, which contains the file’s 
path along with character, word, line, and page counts for the file and 
the selection.
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Document Icon
The Document Icon serves as a proxy for the document file. You can 
click the icon to reveal the current file in the Finder, or drag it 
anywhere the original file can be dragged.

Show All/Hide All
Shows or hides all the icons on the document status bar.

Button Puffiness
When using the Appearance Manager, you can choose the degree of 
the 3D effect used on the status bar buttons, from minimal to 
excessive.

Mac OS X These options have no effect under Mac OS X, and are therefore disabled.

Text Editing Preferences
New in 6 The Text Editing preferences control some of BBEdit Lite’s optional 

text editing features. Many of these preferences were located in the 
Editor preferences panel in previous versions of BBEdit Lite.

Enable Shift-Delete for Forward Delete
When this option is selected, holding down the Shift key with the 
Delete key makes the Delete key work the same way as the Forward 
Delete key on Extended Keyboards. This feature is particularly useful 
on PowerBooks.
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Drag & Drop Editing
When this option is selected, you can use the mouse to drag text from 
one part of a window to another or from one window to another. In 
dialog boxes that let you specify a file, you can drag the file’s icon 
from the Finder to the dialog box.

Note Regardless of this setting, you can drag a file from the Finder (or other 
application) into an editing window.

Use Numeric Keypad for Cursor Movement
To use the numeric keypad to move the insertion point (like Microsoft 
Word), select the Keypad Cursor Controls option.

You can use Shift key with the keys on the numeric keypad to extend a 
selection. You can use the Command and Option keys with the 2,4,6, 
and 8 keys as you would the arrow keys.

Tip To toggle the behavior of the numeric keypad between moving the cursor 
and typing numbers, hold down the Option key and press the Clear key at the 
upper left-hand corner of the numeric keypad. (This key is also labeled Num 
Lock on the Apple Extended Keyboard.)

Allow Single-Click Line Selection
New in 6 If the checkbox is turned on, clicking in the left margin of an editing 

window selects an entire line. The pointer changes to a right arrow 
when it is in the left margin. Click and drag to select multiple lines. 
Double-click to select an entire paragraph; double-click and drag to 
select a range of paragraphs.

If this option is off, clicking in the left margin moves the insertion 
point to the beginning of the clicked line, as in previous versions of 
BBEdit Lite. Note that the line number bar, if displayed, is not part of 
the left margin.

start of line

7
up

8
Scroll up

9

left

4
show selection

5
Right

6

end of line

1
down

2
Scroll down

3
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Confirm Non-Undoable Editing Actions
To have BBEdit Lite stop warning you when you are about to perform 
an action that cannot be undone, turn this checkbox off.

Use ‘Hard’ Line Numbering…

New in 6 If this switch is turned on, then the line number bar, cursor position 
display, and “Go To Line” commands in editing views will use line 
numbers that correspond to “hard” carriage returns in the document, 
rather than to soft-wrapped line breaks. To restore the behavior of 
previous versions of BBEdit Lite, turn this preference off.

Exchange Command and Option Key Behavior
These two checkboxes let you swap the meaning of the Option and 
Command keys when used with cursor navigation keys to move 
through a window’s contents. You can set this separately for 
horizontal and vertical cursor movement. For details on using cursor 
navigation keys, see Chapter 4 and Appendix B. 

Mac OS X Allow Text Smoothing
If turned on, this option allows the system to draw smoothed (anti-
aliased) text in text-editing views. When turned off, text smoothing is 
suppressed, which may make certain fonts and sizes more readable. 
This option is only available on Mac OS X.

Extra Space in Text Views
To have BBEdit Lite leave extra empty space when you scroll to the 
end of a text view, choose Half Window or Full Window here.
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Text Files: Opening Preferences
New in 6 The Text Files: Opening preferences control BBEdit Lite’s behavior 

when it opens files.

Translate Line Breaks
When this option is selected, BBEdit Lite translates DOS or Unix line 
breaks when opening a file. Otherwise, BBEdit Lite leaves the original 
line breaks untranslated.

If a File’s Type is Unknown

New in 6 These settings tell BBEdit Lite how to deal with files whose type and 
creator codes are not set. Usually, such files are created by Unix 
programs running on Mac OS X, but they may also be downloaded 
from remote servers. You can choose:

• Ignore It—BBEdit Lite will behave consistently with previous 
versions: since the file’s type is not “TEXT” (or any other type 
which is recognizable as a text-file type), BBEdit Lite will 
ignore the file in situations where a text file is required.

• Assume It’s Text—BBEdit Lite will assume that the file should 
be treated as text. This will give maximum exposure to such 
files, at the expense of occasionally seeing a file which doesn’t 
actually contain text (like binary data or executable files under 
Mac OS X).

• Map the File Name—BBEdit Lite will inspect the file’s name to 
see if it can figure out whether the file is text or not. BBEdit Lite 
will apply the Internet Config file name mappings. (On Mac 
OS 9 and earlier, you can configure these mappings in the 
Internet control panel; on Mac OS X, a set of default mappings 
is present but these are not currently user-configurable.)
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Regardless of the OS you’re running BBEdit Lite on, you should select 
whichever setting makes the most sense for the sorts of files you work 
with: if the files are downloaded from remote hosts and often don’t 
have correct file types, but you know that they’re always text, then you 
can select Assume It’s Text.

Mac OS X Given that Mac OS X does not set the file type of any text file created 
by a Unix program to a useful value, you may find it more useful to 
use Map the File Name; this will generally yield the best results.

Text Files: Saving Preferences
New in 6 The Text Files: Saving preferences control BBEdit Lite’s behavior when 

it saves files, now including file backup settings.

Force New Line at End
When this option is selected, BBEdit Lite will always add a line break 
at the end of the file if it doesn’t already end with one.

Default Line Breaks
The default line breaks options let you choose what kinds of line 
breaks BBEdit Lite writes when you save the file. You can choose:

• Macintosh line breaks (ASCII 13) if you are using the file only 
on a Macintosh.

• Unix line breaks (ASCII 10) if the file resides on a Unix file 
server or if you’re sending it to someone who uses Unix.

• DOS line breaks (ASCII 13/10) if the file resides on a DOS file 
server or if you’re sending it to someone who uses a DOS 
system
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Make Backups Before Saving
New in 6 Select this checkbox to tell BBEdit Lite to make automatic backup 

copies of every file as you save it. This preference setting establishes 
the defaults for newly created documents, and for documents in 
which there are no saved backup settings.

If you prefer that BBEdit Lite create backup files in the same folders 
that your documents are already saved in, choose the option for Use 
Document’s Folder. This is the default setting.

Should you prefer to save backups in a different folder, choose the Use 
Folder setting instead. You can click the Choose button to select the 
desired backup folder using a dialog, or just drag the folder to the box.

Even if you do not set BBEdit Lite to perform general backups here, 
you can still set backup options for individual files by using the 
Backup Options command on the File menu.

Text Printing Preferences
The Printing preferences control how BBEdit Lite prints your 
documents.

Default for Page Setup
The Page Setup button lets you set the default options for the Page 
Setup dialog box.

Defaults for Printing
The Printing button lets you set the default options for the Printing 
dialog box.
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Default Font
To set the default printing font, click the Default Font button. BBEdit 
Lite opens a dialog that lets you specify the font and the width of tab 
stops. The current printing font settings appear in the text box to the 
right of the button.

Use Document’s Font
When this option is selected, BBEdit Lite uses the document’s font 
when printing.

Fractional Widths
When this option is selected, BBEdit Lite prints proportionally-spaced 
fonts with better letter spacing.

Print Backwards
When this option is selected, BBEdit Lite prints documents last page 
first. This option is useful if you’re printing to a printer like the 
original LaserWriter that does not arrange pages in the proper order.

Frame Printing Area
When this option is selected, BBEdit Lite draws a box along the edges 
of the printed text.

Print Page Headers
When this option is selected, BBEdit Lite prints the page number, the 
name of the file, the time and date printed in a header at the top of 
each page.

Print Full Pathname
When this option is selected, BBEdit Lite prints the full path name of 
the file being printed in the header.

Print Line Numbers
When this option is selected, BBEdit Lite prints line numbers along the 
left edge of the paper.

Print Two-Up
When this option is selected, BBEdit Lite prints two pages on one 
sheet of paper. Use this option to save paper.
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1-Inch Gutter
When this option is selected, BBEdit Lite leaves a one-inch margin 
along the left edge of the paper. Use this option if you usually put 
your pages in three-ring binders.

Time Stamp
The Time Stamp options let you choose whether the date that appears 
in the header is the date that the file was last modified or the date that 
the file was printed.

Text Search Preferences
New in 6 The Text Search preferences let you set default options to use with the 

Find command.

Report Single-File “Replace All” Results
New in 6 When this option is selected, BBEdit Lite displays a dialog telling you 

how many replacements it made when you perform a Replace All 
operation on a single file.

Remember Start At Top Setting
Mark this checkbox to have BBEdit Lite remember the state of the Start 
At Top checkbox in the Find & Replace dialog from one invocation to 
the next.

Grep Patterns
This list displays all the grep patterns (regular expressions) you have 
defined for use in the Find dialog’s Patterns pop-up menu. Click Add 
to add a new one. Click Change to edit the selected pattern. Click 
Remove to delete the selected pattern.
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Note If you have the Preferences window open, you will not be able to add grep 
patterns from the Find dialog. To work around this, close the Preferences 
window before using the Find dialog to add new grep patterns.

Windows Preferences
The Windows preferences control the size and appearance of both 
newly-created windows, and windows which do not contain their 
own display state information. (See the State panel to tell BBEdit Lite 
how to store state information in files.)

Window Zooming
The Maximum Width pop-up menu lets you specify the maximum 
width of a zoomed window.

The Zoom Windows To pop-up menu lets you choose which screen 
BBEdit Lite should use when zooming. You can choose the main 
screen, the nearest screen, the largest screen or the smallest screen. 
(The nearest screen is the screen that contains most of the active 
window.)

Always Zoom Windows
Mark this checkbox to always expand windows to their maximum 
size when opening them, regardless of their saved window size state.

Move As Little As Possible
New in 6 When this option is selected, BBEdit Lite keeps the windows as close 

to their original location as possible when you zoom them.
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Window Stacking
New in 6 These icons determine how BBEdit Lite stacks windows: down and to 

the left, straight down, or down and to the right.

Leave Room for Finder
When these options are selected, BBEdit Lite leaves room on the right 
side or the bottom of the screen so that you can see icons on the 
Desktop.
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C H A P T E R

9
BBEdit Lite Plug-Ins

BBEdit plug-ins (formerly known as BBEdit extensions) are code 
modules that enhance BBEdit Lite’s features, and which appear within 
BBEdit Lite itself on the Tools menu. This chapter describes the basic 
plug-ins that ship with BBEdit Lite. Many third-party developers have 
written additional BBEdit plug-ins, which are available on various 
Web sites (including our own).

If you would like to write your own plug-ins for BBEdit Lite, please 
refer to the BBEdit Plug-in Developer’s Kit, available from the Bare 
Bones Software web site.

In this chapter
Using BBEdit Lite Plug-Ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .133

The Tools Menu and Floating Window – 134
The Set Key Button – 134

Supplied Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .135
Add/Remove Line Numbers – 135
Columnize – 135
Concatenate – 135
Convert to ASCII – 135
Copy Lines Containing – 136
Cut Lines Containing – 136
Educate Quotes – 136
Hex Dump – 136
Make Prototypes – 136
Prefix/Suffix Lines – 136
Reverse – 136
Send PostScript™ – 137
Sort – 137

Third-Party Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .138
Finding more plug-ins – 138

Using BBEdit Lite Plug-Ins
To use BBEdit plug-ins, you need to activate the BBEdit Plug-ins 
option in the Application section of the Preferences dialog.

BBEdit plug-ins are accessed through the Tools menu; any plug-in 
installed in your BBEdit Lite Plug-ins folder will appear on that menu. 
Some plug-ins require that there be an active window or a selection 
range. These tools may be dimmed when this condition is not met.

Plug-ins reside in the Plug-ins folder in the BBEdit Lite Support folder, 
which is in the same folder as the BBEdit Lite application. You can 
group plug-ins into sub-folders (1 level deep) to organize them with 
the BBEdit Lite Plug-ins folder. When you organize your plug-ins this 
way, BBEdit Lite creates submenus on the Tools menu for each folder.
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The Tools Menu and Floating Window
The first item in the Tools menu opens a floating window that contains 
the names of all the plug-ins. Any plug-ins you have installed will 
appear both in this Tool List window and on the Tools menu itself. If 
you have simply installed them in the BBEdit Lite Plug-ins folder, they 
will appear as individual items on the Tools menu. If you have placed 
them into folders inside the main BBEdit Lite Plug-ins folder, then the 
tools will appear in sub-menus that mirror their layout within that 
folder.

In the Tools List window, any plug-ins will appear under the sub-
menu named BBEdit Lite Tools, unless they are in their own folder, in 
which case they will appear in separate sub-menus.

The Set Key Button 
The Set Key button in the BBEdit Lite Tools floating window lets you 
assign key equivalents to a plug-in. You can use any combination of 
the Command, Shift, Option, and Control keys in the key equivalents.

Assigning a Key to a BBEdit Tool
To assign a key to a BBEdit plug-in:

1 Select the tool you wish to assign a key equivalent to in the Tools List.

2 Click the Set Key button to display the Set Key dialog.

3 Type the key equivalent. You can use any key combined with 
Command plus Shift, Option, or Control modifiers if desired. The 
equivalent must use at least the Command or the Control modifier 
key to be valid.

4 Click Save.

Warning If you try to assign a key sequence that is already used elsewhere, BBEdit Lite 
will warn you that there is a conflict and ask you whether you want to reassign 
that key sequence to the new item.

Removing a Key Assignment
To remove a key assignment from a BBEdit Lite plug-in:

1 Choose the Tool from the Tools List window.

2 Click Set Key.

3 BBEdit Lite opens the Set Key dialog.
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4 Click Reset

 BBEdit Lite removes the key assignment from the plug-in.

Supplied Plug-ins
This section describes the standard BBEdit Lite plug-ins installed with 
BBEdit Lite.

Add/Remove Line Numbers
This plug-in applies or removes line numbers to each line of the text in 
the active window or in the selection.

New in 6 Clear Lines Containing
Removes from the active window all the lines that contain a specified 
search string. Unlike Cut Lines Containing, however, this plug-in does 
not affect the contents of the clipboard.

Columnize
Organizes the selected line-delimited text into column-delimited text, 
either by row or by column.

Concatenate
Merges two or more files and places the results in a new untitled 
window.

Convert to ASCII
Converts all eight-bit Macintosh characters in the active window to 
their 7-bit ASCII equivalents. This plug-in is useful for preparing text 
for posting to an information service that doesn’t handle 8-bit 
characters. When selected from the Tools menu, it opens this dialog 
box:

Each pair of buttons on the left half of the dialog determines how to 
convert a particular 8-bit character. The plug-in also converts 
typographer’s quotes (“ ” and ‘ ’) to straight quotes (" and ').
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The pairs of buttons in the right half of the dialog box determine what 
action the plug-in takes. You can choose to convert only the selected 
text (if there is a selection in the active window), and you can choose 
to place the results on the Clipboard rather than replacing the text in 
the window.

This plug-in was written by Jamie McCarthy, based on a prototype 
“Prepare Usenet Posting” plug-in by Rich Siegel.

Note This plug-in can be used to reverse the effects of the Educate Quotes plug-in.

Copy Lines Containing
Copies to the Clipboard all the lines that contain the specified string.

Cut Lines Containing
Cuts from the active window all the lines that contain a specified 
search string. This plug-in places the cut lines on the Clipboard.

New in 6 Starting with BBEdit Lite 6.1, the old Cut/Copy Lines Containing plug-in has 
been replaced by a plug-in named Process Lines Containing which contains 
both the Cut and Copy Lines Containing commands, as well as the new Clear 
Lines Containing command.

Educate Quotes
Converts straight quotes (" and ') to typographer’s quotes (“ ” and ‘ ’) 
in the text of the active window.

Hex Dump
This plug-in provides a hex dump for a file that you choose.

Make Prototypes
Generate ANSI-style function prototypes for existing C functions. This 
plug-in places the prototypes in a new untitled window.

Prefix/Suffix Lines
This plug-in adds or removes a prefix from all the lines of the text of 
the active window or of the selected text.

Reverse
Reverses the order of the lines in the active window, or the selected 
lines.

Salary Adjust
This plug-in directs your payroll service to adjust your gross salary by 
the amount you specify. You must have an Internet connection to use 
this plug-in.
136 Chapter 9: BBEdit Lite Plug-Ins



Send PostScript™
Sends the current document in PostScript™ format to any PostScript 
printer available to your computer. (This plug-in is only available 
when running BBEdit Lite on Mac OS 9 and earlier.)

Sort
The Sort plug-in sorts lines by collating them in alpha-numeric order. 
It can be set to ignore white space at the beginning of lines, sort on 
leading numerical quantities only, ignore case, and sort in descending 
order. (For a more fully-featured line sorting plug-in, check out 
LineSort, a shareware plug-in by Craig Maynard.)
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Third-Party Plug-ins
In addition to the standard plug-ins described above, a wide variety of 
BBEdit Lite plug-ins are available from third parties. 

Finding more plug-ins
An extensive though not exhaustive listing of plug-ins in the support 
section of the Bare Bones Software web site:

http://www.barebones.com/support/plugins.html

Mac OS X Plug-ins

Mac OS X When running under Mac OS X, you will not be able to use any third-
party plug-ins which have not been updated for BBEdit 6.1. Contact 
the developers of your plug-ins or visit the Bare Bones web site for 
more information on the availability of updated plug-ins.
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A P P E N D I X

A
Command Reference

This section is a quick reference for key assignments and a 
comprehensive list of the commands that are available from BBEdit 
Lite’s user interface.

In this appendix
Assigning Keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .139
Listing by Menu and Command Name . . . . . . . . . . . . . . . . . . . . . . .140
Listing by Default Key Equivalents. . . . . . . . . . . . . . . . . . . . . . . . . .142

Assigning Keys
You can assign your own keyboard shortcuts to BBEdit Lite’s menu 
commands by choosing “Set Menu Keys…” from the Edit menu. The 
Set Keys dialog, below, appears.

To set the key assignment for a menu command, find it in the Set Keys 
dialog, click the Set button, and type the desired keystroke.

To remove the key assignment from the selected menu command, 
click the Clear button instead.

Click Reset All to restore all key assignments to BBEdit Lite’s defaults.
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Listing by Menu and Command Name
Apple Menu File:

About BBEdit Lite (none) New (see left column)
Open… Cmd-O
Open Several… Cmd-Opt-O

File -- New: Open Hidden (none)

Text Document Cmd-N Open Selection Cmd-D
  (with selection) Cmd-Shift-N Open File by Name Cmd-D
  (with Clipboard) Cmd-Opt-Shift-N Reveal Selection Cmd-Opt-D

Open Recent (submenu)
Close Cmd-W
Close All Cmd-Opt-W
Close & Delete Cmd-Shift-W
Save Cmd-S
Save All Cmd-Opt-S
Save As… (none)
Save As Selection… (none)
Revert… (none)
Revert (none)
Backup Options… (none)
Make Backup Now… (none)
Page Setup… (none)
Print… Cmd-P
Print All Cmd-Opt-P
Print One Copy Cmd-Shift-P
Quit Cmd-Q
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Listing by Menu and Command Name 141

Edit: Search:
Undo Cmd-Z Find… Cmd-F
Redo Cmd-Shift-Z Find Again Cmd-G
Cut Cmd-X Find Again (reverse) Cmd-Shift-G
Cut & Append Cmd-Shift-X Find Selection Cmd-H
Copy Cmd-C Find Selection (reverse) Cmd-Shift-H
Copy & Append Cmd-Shift-C Enter Search String Cmd-E
Paste Cmd-V Enter Replace String Cmd-Opt-E
Clear (none) Replace Cmd-=
Select All Cmd-A Replace All Cmd-Opt-=
Select Line Cmd-L Replace & Find Again Cmd-T
Select Paragraph Cmd-Opt-L Find In Next File (none)
Insert (see below) Open All Matches (none)
Show Clipboard (none) Find & Replace All 

Matches
(none)

Previous Clipboard Ctrl-[ Go To Line… Cmd-J
Next Clipboard Ctrl-] Go To Line Cmd-Opt-J
Text Options… Cmd-Opt-; Go To Center Line Cmd-Shift-J
Printing Options… Cmd-Shift-;
Preferences… Cmd-; Insert:
Set Menu Keys… (none) File Contents… (none)

Text: File Path… (none)

Font & Tabs… (none) Folder Contents… (none)
Balance Cmd-B Folder Path… (none)
Exchange Characters Cmd-` Page Break (none)
Exchange Words Cmd-Opt-`
Change Case… (none) Tools:
Change Case (none) Tools List (none)
Shift Left Cmd-[

Shift Left One Space Cmd-Shift-[ Window:
Shift Right Cmd-] Window List (none)
Shift Right One Space Cmd-Shift-] Arrange… (none)
Hard Wrap… Cmd-\ Arrange (none)
Hard Wrap Cmd-Opt-\ Get Info… (none)
Add Line Breaks (none) Reveal in Finder (none)
Remove Line Breaks (none) Send To Back Cmd-Ctl-/
Rewrap Quoted Text… Cmd-’ Exchange With Next Cmd-Opt-/
Rewrap Quoted Text Cmd-Opt-’ Synchro Scrolling (none)
Increase Quote Level Cmd-Opt-]
Decrease Quote Level Cmd-Opt-[ Internet Helpers:
Strip Quotes (none) Internet Control Panel (none)
Zap "Gremlins"… (none) News Reader (none)
Zap "Gremlins (none) Mail Client (none)
Entab… (none) FTP Client (none)
Entab (none) Web Browser (none)
Detab… (none) Gopher Client (none)
Detab (none) WAIS Client (none)
Resolve URL (none)



Listing by Default Key Equivalents
Key Command

Cmd-' Rewrap Quoted Text…

Cmd-; Edit: Preferences…

Cmd-= Search: Replace

Cmd-A Edit: Select All

Cmd-B Text: Balance

Cmd-C Edit: Copy

Cmd-D File: Open File by Name

Cmd-E Search: Enter Search String

Cmd-F Search: Find…

Cmd-G Search: Find Again

Cmd-H Search: Find Selection

Cmd-J Search: Go To Line…

Cmd-L Edit: Select Line

Cmd-N File: New: Text Document

Cmd-O File: Open…

Cmd-P File: Print…

Cmd-Q File: Quit

Cmd-S File: Save

Cmd-T Search: Replace & Find Again

Cmd-V Edit: Paste

Cmd-W File: Close

Cmd-X Edit: Cut

Cmd-Z Edit: Undo

Cmd-[ Text: Shift Left

Cmd-] Text: Shift Right

Cmd-\ Text: Hard Wrap…

Cmd-` Text: Exchange Characters

Cmd-left-arrow Search: Apply to Old

Cmd-right-arrow Search: Apply to New

Cmd-Ctl-/ Windows: Send To Back

Cmd-Opt-' Rewrap Quoted Text
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Cmd-Opt-/ Windows: Exchange With Next

Cmd-Opt-; Edit: Window Options…

Cmd-Opt-= Search: Replace All

Cmd-Opt-D File: Reveal Selection

Cmd-Opt-E Search: Enter Replace String

Cmd-Opt-J Search: Go To Line

Cmd-Opt-L Edit: Select Paragraph

Cmd-Opt-O File: Open Several…

Cmd-Opt-P File: Print All

Cmd-Opt-S File: Save All

Cmd-Opt-W File: Close All

Cmd-Opt-\ Text: Hard Wrap

Cmd-Opt-` Text: Exchange Words

Cmd-Opt-Shift-N File: New:   (with Clipboard)

Cmd-Shift-; Edit: Printing Options…

Cmd-Shift-C Edit: Copy & Append

Cmd-Shift-G Search: Find Again (reverse)

Cmd-Shift-H Search: Find Selection (reverse)

Cmd-Shift-J Search: Go To Center Line

Cmd-Shift-N File: New:   (with selection)

Cmd-Shift-P File: Print One Copy

Cmd-Shift-W File: Close & Delete

Cmd-Shift-X Edit: Cut & Append

Cmd-Shift-Z Edit: Redo

Cmd-Shift-[ Text: Shift Left One Space

Cmd-Shift-] Text: Shift Right One Space

Key Command
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A P P E N D I X

B
Editing Shortcuts

In BBEdit Lite you can perform many editing functions (including 
word selection or deletion) directly from the keyboard. Chapter 4 
contains complete details on BBEdit Lite’s text editing features. This 
appendix is a quick reference to available keyboard and mouse 
shortcuts for word selection and deletion.

In this appendix
Mouse Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .145
Arrow and Delete Keys. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .146

Mouse Commands

Triple-clicking is the same as clicking in a line and then choosing the 
Select Line command in the Edit menu.

Holding the Command and Option keys as you click or double-click 
triggers special actions:

No Modifier Shift

Click move insertion point extend selection

Double-click select word extend selection to word

Triple-click select line

Option Command Command/Option

Click Open URL

Double-click look up selected 
word in program-
ming reference

select word and search 
for next occurrence of 
the word
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Arrow and Delete Keys
You can use the arrow keys to move the insertion point right, left, up, 
and down. You can augment these with the Command and Option 
keys to move by word, line, or screens, or with the Shift key to create 
or extend selections. For example, pressing Shift-Option-Right Arrow 
selects the word to the right of the insertion point.

Note The meaning of the Command and Option modifiers listed above may be 
exchanged, depending on which settings you have selected for Exchange 
Command and Option Key Behavior in the Text Editing panel of the 
Preferences.

Key Modifier  Action

(left/right) Arrow (none) Move 1 character left/right

(left/right) Arrow Option Move 1 word left/right

(left/right) Arrow Command Move to beginning/end of line

(up/down) Arrow (none) Move up/down 1 line in file

(up/down) Arrow Command Move to top/bottom of file

(up/down) Arrow Option Move to previous/next screen page

[any of the above] Shift Make or extend a selection range

Delete (none) Deletes selection range, or character 
preceding (to the left of) the insertion 
point.

Delete Command Deletes all characters backwards to 
beginning of line

Delete Option Deletes all characters back to 
beginning of word

Delete Shift (same as Forward Delete)

Forward Delete (none) Deletes selection range, or character 
after (to the right of) the insertion 
point

Forward Delete Command Deletes all characters forward to end of 
the current line

Forward Delete Option Deletes all characters forward to end of 
word

Forward Delete Shift (same as Forward Delete alone)
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A
active windows 36
Add/Remove Line Numbers plug-in 135
alternation 96
Application Preferences 109
Arrange command 66
arranging windows 66
arrow keys 146
ASCII conversion 135
auto-indent 48
automatic backups 29

B
backups 28

automatic 29
manual 29

backward searching 74
balancing parentheses 49, 51
batch find 75, 76
BBEdit extensions

see plug-ins
BBEdit state information 21
BBEdit-Talk mailing list 88
Browser Display Preferences 111
browsers

search results 78

C
C programming language 56
Cancel button 8
capitalize

lines 53
sentences 53
words 53

case sensitivity 74
case transformations 100
changing case 52
character classes 90
Clear command 8, 36
Clear key 36
Clipboard 37
clipboard 37
clipboards, multiple 37
Columnize plug-in 135
Command and Option keys

in document windows 44
Command key 8
command keys

assigning to menu items 139
in dialogs 8
in menus 7
listing by default key 142
listing by menu 140
shortcuts 145

Command-Period 8
complex patterns 94
Concatenate Files plug-in 135
control characters 55
Convert to ASCII plug-in 135
Copy & Append command 37
Copy command 8, 37, 136
Copy Lines Containing plug-in 136
creating documents 18

with clipboard 19
with selection 19

creator 20
cursor movement 42

using arrow keys 43
cursor position 40, 50
Cut & Append command 37
cut and paste 37
Cut command 8, 37, 136
Cut Lines Containing plug-in 136

D
Delete key 36, 45, 146
deleting text 36
Detab command 56
dialog keyboard shortcuts 8
documents

creating 18
double-clicking 20
editing text 36
icon 41
inserting text 62
modification indicator 41
opening 23
revealing in Finder 68
saving 18, 19
window anatomy 40

DOS line breaks 21
double-clicking 20, 23
drag-and-drop

in document windows 39
to BBEdit application icon 20, 23

dynamic menus 7
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E
editing text 36

shortcuts 145
Editor Defaults Preferences 112
Educate Quotes plug-in 136
End key 47
Entab command 56
Enter key 8
Enter Search String command 84
escape codes 56, 89
Escape key 8
Exchange with Next command 69
exclude matches 76
expanding tabs 49
extending the selection 43, 44, 46
extensions

see plug-ins

F
F keys 47
File Search Preferences 115
File Types Preferences 117
File-pop-up menu 41
Find & Replace All Matches 79, 82
Find & Replace All Matches command 85
Find Again command 73, 84
Find All 73, 77
Find command 71, 84
Find dialog 72
Find in Next File command 79, 85
Find Selection command 84
finding text

see searching
floating windows

Tool List 134
window list 66

font
for printing 31

form sentences 53
form words 53
Forward Delete key 45, 47
fractional widths 31
freezing line endings 58
function keys 47
functions

prototypes 136

G
Get Info command 41, 68
Go To Center Line command 85
Go To Line command 46, 85
gremlins 55
grep 74

alternation 96

case sensitive 91
character classes 90
complex patterns 94
entire matched pattern 98
escape codes 89, 92
examples 101
excluding characters 90
longest match issue 96
marking a mail digest 103
marking structured text 103
matching delimited strings 102
matching white space 101
matching words and identifiers 101
modifying HTML tags 104
non-printing characters 92
ranges 90
rearranging name lists 104
repetition 93
replacement patterns 98
replacing with subpatterns 99
subpatterns 94, 98
wildcards 90

H
Hard Wrap command 58, 60
hard wrapping 53, 54, 57, 59
headers 32
Hex Dump plug-in 136
hex escapes 75, 92
hexadecimal 56
highlighting of text 36
hollow diamond 41
Home key 47
HTML 104

see also following entries
human interface 7

I
inactive windows 36
indenting 53
Info button 41
Insert pop-up menu 41
inserting files 62, 63
inserting folder listings 62
inserting page breaks 63
inserting text 62
insertion point 36
installing BBEdit 11
invisible characters 50
invisible files 25

K
key icon 41
keyboard shortcuts 134, 139, 145
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in dialogs 8

L
launching BBEdit 17
line breaks 21, 53
line feeds 55
line numbers 40, 50

on printouts 32
line prefixes and suffixes 136
longest match issue 96
lower case 53

M
MachTen and BBEdit 22
Macintosh Drag and Drop 39

see also drag-and-drop
Macintosh line breaks 21
Make Prototypes plug-in 136
menus 7
mouse shortcuts 145
moving text 37
moving the cursor 42

using the arrow keys 43
MPW

state information 21
multi-file search 75, 76
multiple clipboards 37
multiple Undo 39

N
non-printing characters 50, 75
numeric keypad 46

O
Open command 20, 23

options 25
Open Hidden 25
Open Recent command 23, 25
Open Selection command 23, 27
Open Several command 23, 26
opening documents 23
outdenting 53

P
page breaks 63
Page Down key 47
Page Up key 47
paragraph (definition) 37
Paragraph Fill option 60
Paste command 8, 37
Path pop-up menu 41
pattern matching

see grep
pencil icon 41
Philip Bar 49, 50
plug-ins 133
PostScript 137
Preferences 108

Application 109
Browser Display 111
Editor 44, 46
Editor Defaults 112
File Search 115
File Types 20, 117
Printing 30
Services 12
Startup 118
State 119
Status Bar 120
Text Editing 122
Text Files

Opening 125
Saving 126

Text Printing 127
Text Search 129
Windows 49, 130

Prefix/Suffix Lines plug-in 136
prefixes 136
Print One Copy command 30
printing 30
Printing Options command 31
prototypes 136
pull-down menus 7

R
Redo command 39
reflowing paragraphs 60
regular expressions

see grep
Remove Line Breaks command 58
repetition metacharacters 93
Replace 73
Replace & Find Again command 73, 79, 85
Replace All 73, 77, 79, 82, 84
Replace command 84
replacing text 36

see also searching
Return key 8
Reveal in Finder command 68
Reverse Lines plug-in 136
Rewrap Quoted Text 54
Rez 56
rubber stamp 33

S
Save As command 19
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Save As options 19
file creator 20
line breaks 21
Options button 20
Save As Stationery 20
Save Selection Only 20
state information 21

Save command 19
scrolling, synchronized 69
search results window 78
searching 72

backward 74
batch find 75
case sensitive 74
exclude matches 76
extending selection 74
for non-printing characters 75
for whole words 74
grep 74

see also grep
in a folder 80
in multiple files 76
in results of a previous search 80
in selection only 74
menu reference 84
multiple files 75
non-printing characters 92
replacing in multiple files 81
results window 78
search set 79
wrap around 74

Select All command 8, 36
Select Line command 36
Select Paragraph command 36
selected text 36
selecting text 36, 42

by clicking 43
extending the selection 44

Send PostScript plug-in 137
Send to Back command 69
Shift-Delete keystroke 45
shifting text 53
Show Invisibles command 41
smart editing 49
smart quotes 49
Soft Wrap Text command 41
soft wrapping 49, 57, 58

as default 58
with imported text 59

solid diamond 41
Sort plug-in 137
special folders 12
split bar 42
startup items 17
Startup Preferences 118

state 21
State Preferences 119
stationery 20
status bar 40

hiding 41, 50
Status Bar Preferences 120
subpatterns 94
suffixes 136
Synchro Scrolling command 69

T
tabs

converting to and from spaces 56
Text Editing Preferences 122
Text Files

Saving Preferences 126
Text Files Opening Preferences 125
text highlighting 36
Text Printing Preferences 127
Text Search Preferences 129
text transformation 51
text wrapping 57
time stamps 33
Tool List floating window 134
Tools menu 134
transformations, case 100
Translate Line Breaks 125
translation 135
two-up printing 32
typing text 36
typographer’s quotes 136

U
Un/Comment plug-in 138
Undo command 39
Unicode 22
Unix line breaks 21
upgrading to BBEdit 6 12
upper case 53
user interface 7

W
watermark 33
wildcards 90

see also grep
window list 66
Window Options pop-up menu 41
windows

arranging 66
exchanging with next 69
Info button 68
sending to back 69
split bar 42
status bar 40
150 Index



Windows menu 65
Windows Preferences 130
wrap around 74
Wrap while Typing option 58
wrapping text 49, 57

Z
Zap Gremlins command 55
Index 151


	Title page
	Credits
	Table of Contents
	Ch. 1 - Welcome to BBEdit Lite
	What is BBEdit Lite?
	How Can I Use BBEdit Lite?
	BBEdit Lite is Freeware
	License Requirements
	What’s New in BBEdit Lite 6.1?
	What’s Different from the Commercial Version of BBEdit?
	HTML Editing
	Advanced Text Editing
	Scripting
	Programming
	Even More

	Human Interface Notes
	Dynamic Menus
	Bypassing Options Dialogs
	Menu Command Keys
	Contextual Menus
	Dialog Box Command Keys

	Getting Started
	Changes from Previous Versions

	Ch. 2 - Installing BBEdit Lite
	Basic Installation
	Internet Control Panel
	BBEdit Lite Support Folders
	Plug-ins
	Shutdown Items
	Startup Items

	Other BBEdit Lite Files and Folders
	BBEdit Lite Preferences Folder
	BBEdit Lite Prefs Data
	Clipboards
	Grep Patterns
	Recent Files & Favorites
	Recent Folders & Favorites


	Ch. 3 - Working with Files
	Launching BBEdit Lite
	Startup Items

	Memory Considerations
	Creating and Saving New Documents
	Save As Options
	Save As Stationery
	Save Selection Only
	Options Button

	File Saving Options
	Setting the File Creator
	Saving State Information
	Setting the Line Breaks
	Saving as Unicode


	Opening Existing Documents
	Using the Open Command
	LF Translation

	Using the Open Hidden Command
	Using the Open Recent Command
	Using the Open Several Command
	Using the Open Selection Command
	Open File by Name


	Using Stationery
	Making Backups
	Automatic Backups
	1 Choose the Backup Options command from the File menu.
	2 Specify the folder where you want BBEdit Lite to save the backups. You can choose the document ...
	3 Select the Make Backup before Saving option.
	4 Click OK.

	Manual Backups

	Printing
	Options Available from Print Dialog
	Font Button
	Use Document’s Font
	Fractional Widths
	Options Button
	Print Selection Only

	The Printing Options Command
	Print Backwards
	Frame Printing Area
	Print Page Headers
	Print Line Numbers
	Print Two-Up
	1-Inch Gutter
	Print Full Pathname
	Time Stamp
	Print Rubber Stamp



	Ch. 4 - Editing Text with BBEdit Lite
	Basic Editing
	Moving text
	Multiple Clipboards
	Drag and Drop

	Multiple Undo
	Window Anatomy
	The Status Bar
	The Split Bar

	Cursor Movement and Text Selection
	Clicking
	Arrow Keys
	The Delete Key
	The Numeric Keypad
	Go To Line Command
	Function Keys

	Text Options
	Editing Options
	Auto Indent
	Balance While Typing
	Smart Quotes
	Smart Editing
	Auto-Expand Tabs
	Soft Wrap Text

	Display Options
	Status Bar
	Line Numbers
	Cursor Position
	Show Invisibles


	Font & Tabs
	Text Transformation
	Balance
	Exchange Characters
	Change Case
	Shift Left and Shift Right
	Add Line Breaks
	Remove Line Breaks
	Rewrap Quoted Text
	Increase and Decrease Quote Level
	Strip Quotes
	Hard Wrap
	Zap Gremlins
	Filter Line Feeds
	Zap Non-ASCII Characters
	Zap Control Characters
	Zap Null (ASCII 0) Characters
	Delete
	Replace with Code
	Replace with
	Selection Only

	Entab
	Detab
	Resolve URL

	How BBEdit Lite Wraps Text
	Soft Wrapping
	Soft Wrapping and Imported Text
	Exporting Soft Wrapped Text
	Soft Wrapping and Line Numbers

	Hard Wrapping
	Hard Wrapping Soft-Wrapped Text
	Hard Wrapping and Filling Text


	The Insert Submenu
	Inserting Files
	Inserting a Folder Listing
	Inserting Paths
	Inserting a Page Break


	Ch. 5 - Working with Windows
	Window Menu
	Minimize Window
	Bring All to Front
	Window List
	Arrange
	Get Info
	Reveal in Finder
	Zoom
	Send To Back
	Exchange With Next
	Synchro Scrolling
	Window Names

	Ch. 6 - Searching
	Basic Searching and Replacing
	Search Settings
	Use Grep
	Start at Top
	Wrap Around
	Search Backwards
	Search Selection Only
	Extend Selection
	Case Sensitive
	Match Entire Words
	Multi-File Search
	Batch Find
	Exclude Matches

	Special Characters

	Multi-File Searching
	Multi-File Search Results: Batch Find
	Multi-File Search Results: File by File
	Specifying the Search Set
	Searching the Files in a Folder
	Searching the Results of a Previous Multi-File Search
	Searching All the Open Documents

	Multi-File Search Options

	Multi-File Replacing
	Replacing in Files with Projector CKIDs

	Search Menu Reference
	Find
	Find Again
	Find Selection
	Enter Search String
	Replace
	Replace All
	Replace & Find Again
	Find in Next File
	Open All Matches
	Find & Replace All Matches
	Go to Line
	Go to Center Line


	Ch. 7 - Searching with Grep
	Searching with Grep
	What is Grep or Pattern Searching?
	Recommended Books and Resources
	Mastering Regular Expressions
	BBEdit-Talk

	Writing Search Patterns
	Most Characters Match Themselves
	Escaping Special Characters
	Wildcards Match Types of Characters
	Character Classes Match Sets or Ranges of Characters
	Matching Non-Printing Characters
	Other Special Characters
	Repetition Metacharacters Repeat Other Patterns
	Combining patterns to make complex patterns
	Creating Subpatterns
	Using Alternation
	The ‘Longest Match’ Issue

	Writing Replace Patterns
	Subpatterns Make Replacement Powerful
	Using the Entire Matched Pattern
	Using Parts of the Matched Pattern
	Case Transformations

	Examples
	Matching Identifiers
	Matching White Space
	Matching Delimited Strings
	Marking Structured Text
	Marking a Mail Digest
	Rearranging Name Lists
	Modifying HTML tags


	Ch. 8 - Preferences
	The Preferences Command
	Application Preferences
	Optional Application Services
	BBEdit Plug-ins
	Internet Helpers Menu

	Optional Mac OS Services
	Navigation Services
	Appearance Manager
	QuickTime Translation
	QuickTime Playback

	Show Full Paths in “Open Recent” Menu
	Window menu
	Show Full Paths
	Group by Window Kind
	Sort Windows by

	Remember Dialog Box Placement

	Browser Display Preferences
	Results Lists

	Editor Defaults Preferences
	Auto-Indent
	Balance while Typing
	Smart Quotes
	Smart Editing
	Auto-Expand Tabs
	Show Invisibles
	Show Spaces
	Soft Wrap Text
	Default Font

	File Search Preferences
	Find All Matches
	Skip (…) Folders
	Follow Folder Aliases
	Default <…> Directory
	Unix Search Paths

	File Types Preferences
	To set the default creator signature
	To add a new application to the list
	To delete an item from the list

	Startup Preferences
	Do Nothing
	New Text Document
	Open
	Open Several

	State Preferences
	Honor Saved State
	Window Position
	Font Settings
	Selection Range
	Scrollbar Position
	Option Settings
	Printing Settings

	Default Saved State
	Always Add State

	Status Bar Preferences
	Show Status Bar
	Show Philip Bar
	Show Tab Stops
	Show Line Numbers
	Show Cursor Position
	Window Options
	File Options
	Insert Menu
	File Path
	Get Info Icon
	Document Icon
	Show All/Hide All
	Button Puffiness

	Text Editing Preferences
	Enable Shift-Delete for Forward Delete
	Drag & Drop Editing
	Use Numeric Keypad for Cursor Movement
	Allow Single-Click Line Selection
	Confirm Non-Undoable Editing Actions
	Use ‘Hard’ Line Numbering…
	Exchange Command and Option Key Behavior
	Allow Text Smoothing
	Extra Space in Text Views

	Text Files: Opening Preferences
	Translate Line Breaks
	If a File’s Type is Unknown

	Text Files: Saving Preferences
	Force New Line at End
	Default Line Breaks
	Make Backups Before Saving

	Text Printing Preferences
	Default for Page Setup
	Defaults for Printing
	Default Font
	Use Document’s Font
	Fractional Widths
	Print Backwards
	Frame Printing Area
	Print Page Headers
	Print Full Pathname
	Print Line Numbers
	Print Two-Up
	1-Inch Gutter
	Time Stamp

	Text Search Preferences
	Report Single-File “Replace All” Results
	Remember Start At Top Setting
	Grep Patterns

	Windows Preferences
	Window Zooming
	Always Zoom Windows
	Move As Little As Possible
	Window Stacking
	Leave Room for Finder


	Ch. 9 - BBEdit Lite Plug-Ins
	Using BBEdit Lite Plug-Ins
	The Tools Menu and Floating Window
	The Set Key Button
	Assigning a Key to a BBEdit Tool
	Removing a Key Assignment


	Supplied Plug-ins
	Add/Remove Line Numbers
	Clear Lines Containing
	Columnize
	Concatenate
	Convert to ASCII
	Copy Lines Containing
	Cut Lines Containing
	Educate Quotes
	Hex Dump
	Make Prototypes
	Prefix/Suffix Lines
	Reverse
	Salary Adjust
	Send PostScript™
	Sort

	Third-Party Plug-ins
	Finding more plug-ins
	Mac OS X Plug-ins


	Appendix A
	Command Reference
	Assigning Keys
	Listing by Menu and Command Name
	Listing by Default Key Equivalents

	Appendix B
	Editing Shortcuts
	Mouse Commands
	Arrow and Delete Keys

	Index

